
Bandbreedtes analoog Officieel: CW 500 Hz / NFM 12 kHz / AM 6 kHz / SSB 3 kHz (2.7 kHz)

Meest toegepast: CW 500 Hz / NFM 9 kHz / WFM 15 kHz / AM 6 kHz / SSB 2.2 kHz

Omroep FM 200 kHz (mono 50- 100 kHz) / Omroep KG 5 KHz (beperkte bw)

CONDITIES / PROPAGATIE https://nl.wikipedia.org/wiki/Propagatie_(radio)
==> FM / DAB Temperatuurverandering veroorzaken een verschil in propagatie vanwege het verschil in luchtsoort waarbij de mate van elektische geleiding 

veranderd. Er zijn meerdere soorten:
- grondinversie door  mist of nevel (een warmere luchtlaag ligt dan als een deken over de koudere luchtlaag)
- hogedrukinversie dalende luchtbewegingen in een hogedrukgebied, die botsen op stijgende warme lucht vanaf het warme aardoppervlak
- frontinversie bij een passage van een front (scheidingsvlak tussen koude en warme luchtmassa's)

Antenne Richtantenne is bij condities van minder groot belang omdat signalen soms gewoon van bovenaf op de antenne terecht komen
Beste banden sporadisch De 28 MHz en 50 MHz zijn de beste banden om sporadische dx te meten

ANTENNES

Regel meer elements Een Yagi met meer elementen zal hogere gain en kleinere openingshoek geven. Dit werkt goed als je specifieke zenders wil uitrichten (lees: zonder 
condities). Bij condities komen signalen soms vanaf meerdere kanten in een antenne terecht en is specifiek uitrichten niet nodig en soms zelfs 
onhandig omdat je dan net bepaalde andere signalen kan midden.

Yagi Vernoemd naar de personen die de antenne hebben uitgevonden. De opzet is dat er zoveel mogelijk energie wordt gericht op een enkel element of 
groep kleine elementen en bestaat uit directoren (kleinere elementen aan de voorkant) en reflectoren (schuine elementen in het midden erachter of 
achteraan). Het werkt als een soort lens, door met meer elementen te werken wordt het gebied dat de antenne kan zien kleiner en komt er meer 
energie naar het ontvangende element. Groot voordeel is dat ze kunnen werken in een klein frequentiebereik en op bepaalde frequentie de hoogste 
gain hebben wat handig is bij zenden op 1 frequenteie (zendamateurs). Logper wordt vaak toegepast bij VHF (DAB).

Logper De werking van een Logper is geheel afwijkend van de Yagi. Meer elementen ontvangen het signaal en door de verschillende lengtes kunnen ze werken 
in een breder frequentiegebied. Voor alleen ontvangst is dit handiger. Bij een logper kunnen ook passieve elementen gemonteerd zijn, deze hebben 
alleen tot doel om het signaal te weerkaatsen waardoor en werking verbeterd. Een logper kan zo breed ontvangen, soms zelfs van 50 tot 1000 MHz. 
Logper wordt bijna nooit voor de UHF gebruikt omdat die frequenties even goed reageren op een eenvoudiger Yagi-ontwerp.

Plaatsing naast elkaar Afstand is niet belangrijk zolang er geen harmonische relatie is (bv 2 meter en 70 cm is niet slim want 3x144=432 en dat is de 2e harmonische. Bij DAV 
geldt zelfde 2x100=200). In dat geval kun je die antennes beter verder van elkaar afzetten, echter in de praktijk valt die beinvloeding vaak nog wel mee. 
Ook er op letten dat je voldoende afstand tot de mast hou anders gaat die meedoen als element en verstoort het ontvangst.

Horizontale polarisatie Vertikaal is goed als je FM gebruikt op 2m/70cm om verre repeater te kunnen bereiken. Amateurs in CW en SSB gebruiken alleen horizontaal op die 
banden Dus hangt van doel af, marifoon is altijd vertikaal en de FM band ook (alle omroepen zenden vertikaal uit, alleen als je buitenland wil horen en 
oost Europa is Horizontaal beter - dan zijn de NL zenders ook minder sterk). Als je porto en mobiele stations wil werken maakt het niet uit omdat het 
signaal door de stand van de zendantenne en reflecties door gebouwen vaak wisselt in polarisatie.

In buitenland zijn nog wel veel zenders horizontal en tussen 82 en 87.5 zit nog veel DX.



Coax kabel/ferrietkernen Laat coax altijd een lus weglopen van het aansluitpunt en niet langs de middenboom laten lopen, anders gedraagt de coax zich als de mast. Wat soms 
helpt is split core ferrite op 30 cm afstand tussen elkaar op de coax plaatsen. Lus is beter omdat je dan direct weg bent bij de antenne.

Ferrietkern is ter voorkoming van storingen door interferentie op de kabel zelf. De aangesloten bekabeling van de gestoorde apparatuur is vaak 
onbedoeld een antenne. Probeer dit effect eens tegen te gaan door ferriet materiaal te plaatsen rond alle inkomende/uitgaande kabels van de 
gestoorde apparatuur. Direct bij in- en uitgangen van apparatuur ferrietkralen aan te brengen over de gelijkstroom (DC) kabels. Wel moet ferriet voor 
het juiste frequentiegebied worden toegepast (HF-band). Hoe groter het raakvlak tussen ferriet en bedrading, hoe beter de werking is.

Type 31 is een breedband kernmateriaal een mantelstroom oplossing (common mode) oplossing voor 1 tot 600 MHz. Voor laagfrequente storing 100 
kHz tot 3 Mhz is type 77 geschikt.  https://ferrite-shop.nl/producten/10-mm-ferriet-snap-on-klem/?v=1a13105b7e4e
https://ferrite-shop.nl/voorkom-storing-van-zonnepanelen/?v=1a13105b7e4e

QYT KT8900R / QYT KT8900D

Config > Basic Settings Key Beep OFF / Scan Resume method: CO (Carrier operated) / Display mode A: Name / Display mode B: Name / Squelch level 2 / Time Out Timer 600 
sec / Main LCD bacjground color: Black

Config > Advanced Settings Power-On messages: alles leegmaken
Config > Work Mode Settings VFO/MR [x] mode: alles op channel / MR [x] channel: op welk kanalen moet systeem opstarten
Apart instellen in apparaat Menu+6: TOA (zetten op OFF)
Scannen kanalen Aparte knop op mike */SCAN / kanalen die niet gescand mogen mogen kun je instellen als pass in kanalenlijst
Programmeren Via Chirp

ICOM IC-2730E dual band zendontvanger

Info 1000 kanalen over 10 banken / Power: ontvangen 1,2A en zender 10,5A / ontvangst: 118 - 174 MHz en 375 - 550 MHZ / zenden: 144 - 146 MHz en 430 
- 440 MHz 

Config / Sounds - Beep Level: 0 / Beep (alles uitzetten)
Config / Display - Memory Names: AAN
Config / A/B Bank Settings - A/B Band: Scan Pauze Time: HOLD (zodat tijdens scannen niet na x sec het scanner doorgaat)
Main / Band 1 seconden indrukken om gebruikte band (VFO modus) of geheugenbankselectie (geheugenmodes) te doen
MR Call Omschakelen tussen CFO en kanalen
LOW / DTMF Om te schakelen tussen laag (5W), midden (15W) en hoog vermogen (50W)
MW Druk 1 seconden in om naar kanaal edit modes te gaan en daar een kanaal op SKIPPEN te zetten



Scannen Druk 1 seconden SCAN in en kies of je BAND, ALL enz voor scannen
In apparaat zelf instellen onder Menu / EXMenu / Scan / Pauze op HOLD zetten anders loopt deze na x seconden door bij het scannen

YAESU FT70D

Programmeren 1) Haal de accu uit portofoon en sluit vervolgens USB kabel aan. (soms 1x even porto met aan/uit knop aan en uitzetten)
2) Doe de stroomstekker rechtstreeks in porto terwijl je de knop AMS ingedrukt hou (er komt dan ADMS op display te staan)
3) De porto zal nu met computer verbinding maken, lees via apparaatbeheer PC uit op welke COM poort.
4) Software Yaesu kan niet opslaan, dus je leest gegevens uit de porto en upload deze daarna weer terug naar de porto. Chirp werkt niet helemaal 
goed omdat het invoeren van 8,33 raster voor luchtvaart niet wordt ondersteund.
5) Data lezen uit de porto: start in programma het downloaden en druk daarna op de knop BAND (dus pas na OK drukken)
6) Data schrijven naar de porto: druk eerst op de knop MODE en start daarna in programma oploaden (dus eerst MODE drukken op porto)

RT Systems kabel

Problemen Het lukt via Chirp niet om luchtvaart in 8,33 kHz raster in te voeren terwijl de originele Yaesu programmeersoftware het wel kan.
Tone Mode (T Sql) BIJ DE FT70D WERKT T-SQL NIET GOED BIJ REPEATERS OMDAT NIET ALLE REPEATER OOK TOON MEE UITSTUREN

Tone: alleen toon meesturen, squels blijft open voor alles / T Sql: toon meesturen en squels alleen als ook die toon ontvangen wordt
Scannen kanalen F + 2 / je kan laten scannen per band of alles (MEMORY = alles / bank selecteren kies F + BAND en kies dan gewenste bank om de scannen)
Squekch F + MONI/T-CALL 
AMS Automatic Mode Select: kiest de mode voor zender afhankelijk van de signalen die worden ontvangen. Ideaal als repeater zowel analoog als C4FM 

uitzend. De andere optie Auto Mode kiest automatisch als er signaal in FM of AM wordt ontvangen jaar die uitzendmode.
Skip kanaal F + 9 (vast pijlje in display: skip memory / knipperend pijltje in display: alleen aangewezen kanalen worden gescand (werking niet duidelijk)
Bank linking Je kan banken koppelen zodat bij scannen meerdere banken worden gescand, instellien kan alleen via de RT Systems software en niet in apparaat.
Zoeken frequenties Ga naar Memory en ga lager dan kanaal 1, daar zijn de zoekgebieden te vinden.
Config TX/RX Mic Gain Level 9 / BEEP SELECT off / MON/T-CALL: monitor / TOT: OFF / Scan Resume SCAN en DW 'Busy'/ San Width Memory ALL CH / Volme 

Level 20 / Quelch level 4 / Lamp: 10 seconden

YEASU FT5D

Programmeren Druk op F-menu en start scanner op om in clone stand te komen
Config Audio Mic Gain Level 9
APRS 20 GPS Power ON / 24 My Position GSP / 23 CALLSIGN PD8RSP-7 (-7 staat voor porto's) / 4 APRS Modem 1200 bps / 26 My Symbol Icon 1 / Werkt 

alleen op VFO B / 14 Beacon Interval 5 min (testen 30 sec) / 15 Beacon Status Text ON "Yeasu FT3D / 8 APRS Mute AAN / 26 Position comment (kun je 
EMERGENCY bij nood aanzetten)
- LET OP! Zend alleen GPS uit als de GPS informatie is ontvangen / normaal modem 4 modem en 20 gps uitzetten om accu te sparen
- Lijst van APRS Stations: F > S.LIST (klik op DISP om meer info van pakket op te vragen)

Tone Mode Tone: alleen toon meesturen, squels blijft open voor alles / T Sql: toon meesturen en squels alleen als ook die toon ontvangen wordt
SD Card Formateren die ik in FT5D / Formaat kan zijn 2, 4, 8, 16 of 32 GB.



YEASU FT-897

Programmeren Met Chrip, ontvanger in clonestand door de starten met MODE < > in te drukken / verzenden werkt alleen als je eerst RSV op ontvanger indruk.

BAOFENG DM-1801UV (DMR)

Algemeen 1024 kanalen / 5 Watt vermogen / VHF 136-174MHz & UHF 400-470MHz / Digitale: Tier I & II
Scanner werkt met zones (groep met kanalen), je kan maximaal 150 zones opslaan en iedere zone heeft max 32 analoge of digitale kanalen.
Je kan maximaal 10 scanlijsten aanmaken met 16 kanalen / labels maximaal 16 karakters (meestal maar 10 zichtbaar op display)

Programmeren Controleer voordat je config gaan uploaden altijd in systeem welke com poort wordt gebruikt.
LET OP! ALleen CTCSS voor TX instellen en niet RX want als signaal niet sterk is valt geluid telkens weg

Settings Dual standby: Double Double (scan werkt dan niet ) of OFF (laat dan zone en kanaal zien)
SQ: Squelch Normaal (bij Tight wordt gefilterd op storing maar daardoor kunnen ook zwakke stations wegvallen) 
Key Settings SK1: short: Zone Select Long: High/Low Power + SK 2 short: Scan On/Off Long: Monitor

Scannen Scannen werkt alleen als kanaal in de scanlijst staat / autoscan enable + scanlijst kiezen / kanaal 01 wordt altijd meegescand (geen idee waarom) / Scan 
starten kan alleen als je op een kanaal staat die in die scanlijst staat en dan druk op 'autoscan'.
STAAT LOS VAN ZONES! SCANKANALEN NIET DUBBEL GEBRUIKEN ANDERS WEET PORTO NIET WELKE SCANGROEP DEZE MOET GEBRUIKEN! ALS JE 
DIT WEL WIL DAN MOET JE DE KANALEN EXTRA INVOEREN MET ANDERE NAAM. BIJ KANAAL WEL JUISTE AUTO SCAN GROEP KIEZEN.

DMR instellen / repeater 
benaderen

DMR werkt alleen als je aan DMR kanaal een contact koppel (dus mag ook fictief zijn) en je porto ook een ID heeft (b.v. porto)
Onder Basic Config altijd de Radio Name (Call) en Radio ID (DMR nummer) invullen.
Onder Contacts de groepen invullen waar je aan wilt deelnemen (Nederland = 204), koppelen bij het kanaal
Onder Receive Group zet je alle groepen die je wilt kunnen ontvangen, koppelen bij het kanaal
Bij kanaal altijd Contact, receive group, Polite ENABLE, PTT State CHANNEL FREE (porto wacht dan tot kanaal beschikbaar komt want kan andere 
Talkgroup op actief zijn), TS meestal 1, CC meestal 1 (meestal staat dit vermeld op de site van de repeater)

OpenGD77 Kreeg deze software niet werkend, com poort werd niet herkend terwijl die wel beschikbaar was.

AOR DV-10

ER IS EEN PROBLEEM MET BACKUP MAKEN DUS GEEN BESTANDEN UIT DV10 GEBRUIKEN

Modes

YEAS = C4FM / T-DM = TETRA mobile to mobile / D-CR = NXDN
T-TC = TETRA voice decoding traffic channels (kanaal kiezen via MODE (long) + 5 / TC slot - normaal staat deze op auto)
Als kanaal DMR en NXDN in combinatie gebruikt altijd AUTO gebruiken

AUTOdetection
Herken automatisch een digitale modes, werkt niet bij TETRA
Er is nu ook een A-AUTO die automatisch analoge signalen kan herkennen

CTCSS Stuurt extra toon mee waarmee squelch van ontvanger wordt vrijgegeven (tussen 60 en 254,1 Hz)

DCS Stuurt digitale code mee waarmee squelch van ontvanger wordt vrijgegeven (tussen 017 en 754)

CONFIG SETTINGS Power Save OFF / Auto Region EURO / Beep 00 / Backlight CONT /

system.csv Is complete backup dus ook van alle mem kanalen en bankindelingen



UNIDEN UBC125XLT

Config Beep UIT (Func + 7) / Lampje altijd AAN (Func + powerknop)
Close Call Automatisch kanalen in nabijheid zoeken / 10 laatst gevonden kanalen worden opgeslagen tot scanner uitgaat

- Close Call DND: Alleen Close Call checken maar niet huidige transmissies onderbreken / opslaan kan door tijdens vinden op Pgm/E te klikken
- Close Call Only: Alleen Close Call toepassen (dus niet kanaalscan of bandsearch doen) / druk op Scan of Srch/Svc om uit deze modes te gaan
- Oproepen of laten meescannen van Close Call kanalen kan door tijdens scannen op de Clr knop te drukken, via hold kun je dan gaan naar kanalen

Zoeken servicebanden Func > Srch / zeven banden met voorgeprogrammeerde kanalen / 1 Emergency / 2 Freenet / 3 PMR / 4 Marine / 5 Aircraft / 6 CB Radio / 7 Ham Radio / 
Systeem geeft ook de CCCSS/DCS tonen weer

Snel zoeken Vanuit scan of zoek op Hold drukken  > voer frequentie in> Hold > Srch om zoeken te starten (scroll knop om omlaag of omhoog te gaan)
Normaal zoeken Srch / 10 zoekengebieden en Clr (Close Call kanalen). Zie tab BANKEN voor de indeling
Frequenties uitsluiten 100 tijdelijk en 100 permanent uitsluiten / L/O 1x drukken is tijdelijk uitsluiten en L/O 2x drukken is permanent uitsluiten

- Alle lockouts bekijken kan via (sta in srch mode) Func > Pgm/E > Review Lockouts >  Review Freq L/O (Unlock alles kan ook via zelfde menu) of vanuit 
srch modes op hold drukken en daarna L/O ingedrukt houden.

Omschakelen modulatie Funct > 9 (AM of FM) - na uitschakelen wordt deze keuze weer teruggezet in basisinstelling
Omschakelen step Funct > 3 (kies daarna gewenste stap)  - na uitschakelen wordt deze keuze weer teruggezet in basisinstelling
Butel software Export van bank naar HTML / import file vanaf hpd file / csv export (komma gescheiden en met waarden tussen " / freq notatie met punt
Butel software Virtual Control Met VC kun je via PC de scanner bedienen maar ook logbestanden laten opslaan van zowel scannen als zoeken van frequentiegebieden

Auto Resume: na x aantal seconden automatisch verder scannen van kanalen.

UNIDEN UBCD160DN

Ontvangst VHF De scanner is heel erg doof op de VHF, marifoon en HAM 2 meter komen amper door vergeleken met de UBC125,

BAOFENG BF-R5 MINI-PORTOFOONS

Specs 16 kanalen, te programmeren met CTCSS en DCS codes, 400 - 470 MHz, 500 mW, ook PMR446
Config Time Out Timer (TOT) UIT
Programmeren

RDS TEF6686 / DEEPELEC DP-666

Taal omzetten Klik op mode > Menu 3 Weergave > Taal Nederkands (staat standaard op Chinees)
Weergave Batterij weergave > UIT / Thema > Essence
FM instellingen Band ondergrens: 85 MHz
AM instellingen

Selecteer FM banden FM,OIRT
RDS instellingen RDS filter > UIT / Toon rds fouten: Alles (zodat je bij condities al snel RDS kan aflezen ondanks fouten) / Toon underscore in RDS > UIT



Knop I/O achterop 0 = externe antenne / 1 = ingebouwde antenne
STA kort = wisselen tussen banden / lang: RDS informatie bij FM opvragen (nog keer lang zoeken naar alle alternatieve frequenties)
MODE kort =  manual mode+own mode+radio storage mode / lang: menu interface
BW kort: stereo en mixed sound / lang = bandbreedte kiezen
SQUELCH Instellen van moment van filteren / ruisonderdrukking
VOLUME Volume instellen / indruikken = mute
ROTARY Instellen van frequentie  en in manual mode het instellen van de frequentiedrift
Afstandsbediening Clock = band kiezen / RPT = bandbreedte

HACKRF

Frequentiecorrectie -41,5 ppm (steeds opnieuw instellen, wordt niet goed opgestart)

RADTEL RT-950 PRO

Zones Porto heeft 15 zones met ieder 64 kanalen / Omschakelen via menu > zone
Work Band Porto werkt in band 18 - 64 MHz of 64 - 99 MHz. Geprogrammeerde zones werken dan ook alleen in bepaalde workband.

Omschakelen tussen workband: Ga naar menu en kies voor Radio Set > Workband. Porto wordt gereset na omschakelen
Programmeren Controleer na aansluiten welke compoort, gebruik eigen software Radtel om te uploaden, dan zie je ook alle extra opties
Programmeren met Chirp Start Chirp op in Devolper Mode (menu Help), laad daarna onder Bestand/Modiule Radtel.rt950pro.py file. Daarna kun je commiceren met porto
Optional Features TOT (Time Out Timer): OFF / SQL Level: 3 / Auto Blacklight: 30 sec / Beep Prompt OFF / Voice Prompt OFF / Display Mode A+B+C: Name /
Key programmeren long 0 = RADIO / 1 = SQUELCH / 2 = SCAN QT / 3 = ZONE SELECT / 4 = SPECTRUM / 5 = TX POWER / 

6 = CH MEMORY / 7 = FREQ STEP / 8 = BT WRITE FREQ / 9 = APRS SWITCH
FM/AM/SSB modulation Voor het programmeren van kanalen voor MG/KG en FM
APRS Send custom mesages: OFF / Cal Sigm: PD8RSP / Vul coordinaten in / My Position: GPS coordinates / Beacon Tx Type: Manually Send
Scannen kanalen

RTL-SDR (R820T2 V3)

Installeren versie 3 Versie 3 werkte niet gelijk op SDR# en HDSDR. Voor HDSDR moest Zadig worden installeerd en kon daarna met juiste dll wel RTL stick worden gebruikt. 
Voor SDR# was een andere dll nodig. Staat apart in de map onder V3. 
Settings Zadig: Bulk-In, Interface (Interface 0) / Dirver NONE / USB ID: 0BDA 2838 00 / Geen WCID / Install WinUSB (v1.6.7600.16385).

Direct sampling Om KG te ontvangen moet in SDR# direct sampling (Q-Branch) worden aangezet. 
RTL-SDR Blog v4 Gebaseerd op de R828D tuner / Moet nieuwe dll gebruikt worden bij v4 (is een X86 en X64 versie) / SDR# gebruikt altijd de X86 versie /

AIRSPY MINI / AIRSPY R2



Config Gebruik Liniair in SDR#, zie afregelen signaal SDR SHARP beschrijving
SpyVerter RF Input zit in midden, RF output naast USB aansluiting (hoeft niet aangesloten te worden) / Gebruik op HF alleen linaire gain mode

CORRECTIE: -5,41
Airspy R2 IQ opnames Kan FM tot 8 MHz breed opnemen maar gaat wel ten koste van de gevoeligheid van signalen en vangt meer storingen op

ELAD S2

Settings Graphics > General > Refresh time: 20 ms (standaard 60 ms)
Graphics > AF & IF, MEM en LOG, RDS & DRM always on top, other windows always on top
Graphics > Add Time Stamps in Waterfall
Preselectors Filter ID 8 0 - 54 MHz

Set > Advanced Device Configuration: standaard op 1536k (1228,8 kHz bandbreedte) / voor 5 MHz andere dll kiezen
ZET OP LAAGSTE BANDBREEDTE VOOR BESTE SAMPLING BV OOK BIJ NDB OM MORSE TE HERKENNEN

Bediening - Lock to CF: Lock afstemming altijd op midden van frequentie spectrum
CW D-Res om digitaal resonatie filter te activeren waardoor tonen beter doorkomen bij morse

SH+ / SH- om af te stemmen op de morsetonen en draaggolf niet bv alleen 1 KHz toon laten horen
(AANPASSEN AFSTAND VIA SET > DEMOD SETTINGS > CW SH DELTA FREQ. voor NDB op 400 Hz zetten)

Sync AM / ECSS - Als W gekozen is wordt eerst de waarde van Filter BW gebruikt en zodra gelockt wordt filter op Lock BW ingesteld.
- Als N gekozen is wordt gelijk de waarde van Lock BW gebruikt.
- Met F M S kan de snelheid van de vergrendeling worden ingesteld
- Mode ECSS pakt bv alleen LSB of USB deel om betere kwaliteit te krijgen.

Ontvangst middengolf Zetten op Sync AM (settings andere gebruiker: Lock BW 150Hz / AGC off / Narrow / Medium)
Display waterfall Goede keuze is - 59 - 125 (soms wordt ook -40 t/m -140 gebruikt en dan hele bank schuiven afhankelijk van ruisnivo)
Record IO - ELAD kan alleen eigen formaat afspelen  maar speelt wel meerdere files achter elkaar af

- Opnemen kan tot max 5 MHz breed
- Afspelen op SDR#, zorg dat formaat is #T_#FHz en zorg dat ELAD staat op exact midden van de band (dan werkt afspelen goed).
- ELAD kan bestanden aanmaken groter van 4 GB / zet op 51200 MByte (zodat enkele grotere bestranden ontstaan)
- Zet Max file nummer op 0 als systeem meer dan 1 bestand moet aanmaken (gaat dan door tot schijf vol is). 
OPNEMEN WERKT SOMS NIET GOED VIA SCHEMA. EERST OUDE VERWIJDEREN EN DAN NIEUW SCHEMA ERIN ZETTEN!
LIJKT OOK OF ELAD MOEITE HEEFT ALS BESTANDEN GROTER ZIJN DAN 4GB DEZE OP EXTERNE SCHIJF WEG TE SCHRIJVEN

Morse Gebruik CW SH+ of CW SH- om morse te kunnen beluisteren / in deze modes wordt op draaggolf afgestemd maar wel de 1 Khz toon hoorbaar gemaakt
CSVUserlistBrowser config ELAD en CSVUserlistBrowser kunnen ook, net als bij SDR# samenwerken om de juiste data te tonen.

- ELAD: Ga naar Settings / Remote Ctrl / Enable TCP server en vul een IP adres en poort 1893 in
- CSV: Ga naar Options / Settings / Com/TCP: Kies zelfde IP adres en poort als ELAD en kies Apply COMport/TCP settings
- Start beide programma's opnieuw op

Eigen memomybanks - Je kan verschillende xml bestanden aanmaken met eigen kleurcodering en dan eenvoudig kanalen toevoegen aan bepaalde mem databases.
- Er wordt geen bandbreedte opgeslagen dus je kan daarmee nog altijd schuiven na oproepen van kanaal.
- Bewerken kan ook met Excel, dat werkt makkelijker. Zorg dat freq in kHz staat. Functies gebruiken om eigen log om te zetten naar xml.

Audio via VAC Channel 1 / VRX1 enable / Output device Cable Input (VB Audio Virtual C) = met volumeregelaar 2 dan te regelen



Tuning Zijn de knoppen in te stellen in het rechterpanel om snel de juiste band te kunnen selecteren.
Ontvangstbereik ELAD kan ook 70 MHz ontvangen, officieel buiten het bereik.

SATELLIETONTVANGER GTMedia V8X DVB-S-S2-S2X

Scannen 1) Laat ontvanger alle satelliet afzoeken en richt antene af met finder (door net toon uit te zetten) / 2) Na scan zie je ontvangen zenders zoek op 
internet op welke satelliet je binnenkrijg 
3) Wis alle kanalen in ontvanger en laat nu alleen zoeken op deze specifieke satelliet

Handmatig zoeken Je kan handmatig een kanaal erin zetten door een testsatelliet aan te maken / Menu Antenne setup > TP > Add > Symbol Rate (zie nl.kingofsat.net balk 
met kanaalgegevens

Firmware Download nieuwe firmware (.bin file) vanaf www.freesat.cn en kies voor GTMedia V8X firmware, zet op USB stick en kies voor USB Upgrade

ANDROID APPS (VOLGORDE VAN MEEST GEBRUIKT)

Radiogarden Luisteren naar streamingstations wereldwijd door middel van geografische ligging

PadTV HD (DVB-T) Werkt alleen met MyGica PAD TV Tuner

SDR++ Kan ook AirSpy mini en HF+ ontvangen / zie aparte kop

KiwiSDR Remote SDR ontvangen op tablet

Skywave Schedules Actuele overzichten kortegolfzenders wereldwijd / staat niet in Google moet via site gedownload worden
https://skywave-schedules.en.uptodown.com/android/download 

GPS Test GPS satellieten ontvangen en kompas

Magnetometer Meten van magnetische velden

RepeaterBook Repeaters zendamateurs in bepaalde regio opzoeken

EchoLink Luisteren naar repeaters wereldwijd / inloggen vereist

SignalID Digitale signalen herkennen

Spectroid Audio tot 10 kHz visueel weergeven

Ventusky Laat overgangen tussen lage en hoge drukgebieden zien

VesselFinder Live tracking schepen

MarineTraffic Live tracking schepen

Flightradar24 Live tracking vliegtuigen

SDRTouch Uitgebreide ontvanger tussen 50 MHz - 2.2 GHz met FM, USB, LSB, AM en CW
Programma werkt met RTL dongle (RTL2832U chip), HackRF (voor beide rtl-sdr driver installeren) / SDRplay RSPdx lijkt niet te werken (sdrplay driver 
installeren)
Betaalde versie (7 euro)  met SDR Touch Key om licentie te activeren



Spectrum Analyze In beeld brengen van alle geluiden tussen 0 en 21 kHz

LINUX

ctr+Alt+T Command Line

Synaptic Package Manager Hulpprogramma om makkelijker programmaś voor Linux op te zoeken en te installeren

SDR voor Airspy R2 GQRX en CubicSDR installeren

Driver / API voor Airspy SoapySDR installeren (werkte niet direct maar ineens zag CubicSDR de Airspy wel)

Welle.io DAB zenders zoeken / programma werkt

Snelheid testen Airspy airspy_rx -r /dev/null -t 0

CSV USERLISTBROWSER

Locatie instellen Tools / QTH Manager / Vul bij Main QTH je eigen coordinaten in
Configs Zie ELAD en SDR# software

Updaten database Via web / downloader converter (alleen FMscan en AMscan moet handmatig)

KLINGENFUSS NASLAGWERK UTILITY STATIONS

USB STATIONS Let op Klingenfuss vermeld de frequentie als je via CW afstemt, maar echte frequentie bij STANAG ligt lager 1,8 kHz lager

WAVVIEWDX

Uitlezen Zet software op staande monitor zodat je hele nacht beter kan uitlezen
Tijd (LET OP!) Laat altijd de GMT tijd zien dus niet de lokale tijd in programma
Inleiding Programma om IQ opnames heel snel te analyseren, je krijgt een grafiek in tijd en frequentie van alle opnames die gemaakt zijn en ziet dan precies 

maar signalen ineens sterker werken. Je kan afspelen in het programma.
Importeren Let bij importeren erop dat je voor MW grid van 9 KHz of 10 KHz gebruikt (zo kun je ook Amerikaanse stations analyseren)
FM Band Werkt ook om Fm band te analyseren / geen OIRT band kan afgespeeld worden
Bediening Pijltjes werken gewoon voor navigatie / gebruikt shift voor halve minuut / control voor hele minuut / beide voor 5 minuten

HDSDR

Install Installeren in de root ivm adminrechten / na openen koppelen met dll van ontvanger (deze zetten in installatiemap van programma)
Settings Options > Visualization > RF Display > Set high speed for spectrum

http://welle.io/


SDR++

Algemeen Werkt op PC, Linux en Android / Ideaal programma voor monitoren en uitpeilen van Tetrazenders.
Afspelen IO Kan Sharp# WAV FULL afspelen, kan SDRUno bestanden afspelen (zonder frequentieindicatie)
Record IO Wave bestanden van SDR++ kunnen op SDR# worden afgespeeld / Bij tablet werkt dit niet goed, opnames zijn niet meer terug te vinden
Remote SDR Kan Spyserver remote stations ook ontvangen
Settings FFT Framerate: 10 / Color Map: GQRX / Fast FFT
Frequency Manager Kan groepen aanmaken / Kanalen worden getoond in display / Mogelijk om lijst te exporteren / Nadeel prominent aanwezig, bij scrollen valt tekst weg 

en labels staan over elkaar heen
Modules Daarmee kan via plugins de functie van SDR++ worden uitgebreid / gooi de DLL in de juiste map

SDR SHARP

Installatie Na herinstallatie staat bij Audio Processor het Bandpass filter aan (geluid is daardoor erg smal - telefoongeluid) / Bij paneel Audio de optie 'Filter Audio' 
uitzetten / Standaard staat Tracking Filter en Enable HDR in Source Paneel aan / Gain op Liniair / Decimination: none (anders raak je bandbreedte kwijt)

Als je kiest voor smallere bandbreedte is de ontvangst beter omdat er dan minder gestoord wordt door omliggende frequenties en je Gain hoger 
kan zetten.

Install plugins Plugins hoef je alleen in Plugin map te zetten, XML hoeft niet meer aangepast te worden. Kies bij installatie voor Community pakket + extra installeren: 
RTL_433

Er is een Community versie waarin allerlei plugins zijn voorgeinstalleerd maar deze werkt niet stabiel, beter vanaf lege versie vanaf SDR# site de eigen 
gewenste plugin installerenen verder geen extra niet gebruikte plugins in de map te zetten. https://sdrchile.cl/en/

Bij de oude versies kun je de plugin gewoon in de root erbij zetten en moet je plugins.xml aanpassen door een regel toe te voegen bijvoorbeeld
<add key="Tetra" value="SDRSharp.Tetra.TetraPlugin,SDRSharp.Tetra"/>

Afregelen signaal Zet ontvanger op Linear anders slechter signaal bij Yagi
Verhoog de versterking totdat de natuurlijke ruisvloer met ongeveer 5dB stijgt. Blijft daarna verhogen tot de versterking ineens verder boven die grens 
uitschiet

Controller RTL RTL AGC mag aan, RF Gain is belangrijkste om signaal goed te krijgen bv 28 dB (zet niet te hoog want door oversturing komen dan zenders die eigenlijk 
daar niet uitzenden)

Tracking filter Voor onderdrukking van interferentie op korte afstand / ALTIJD AAN ZETTEN / Als deze aanstaat kan meer gain worden ingesteld.
Display Resolution: 131072 (standaard = 32768  - speed dat iets hoger zetten / smoothing: S-Attack 5 S-Decay 2 W-Attack 13 W-Decay 11,5
SDRPlayDX Versie 1.0.0.1716 kan door toevoegen van SDRSharp.USRP.dll en de IQ dll van SDRPlay in de root ook SDRPlayDX gewoon afspelen
Filter Stel filter in die gebruikt wordt bij omzetten van signalen, Blackman-Harris-4 filter voldoet meestal het beste.
Order Pas de steilheid van de filterranden aan. Bij 10 tot 50 is deze geleidelijk, bij 100 tot 500 is de overgang direct. Het effect is hoorbaar op de audio. 

Standaard staat deze op 500. Zelf op 1000 ingesteld.



Samplerate Normaal op 768 ksps
DSB/SAM modes Gelijk aan AM maar kan betere modulatie opleveren omdat beste van de USB en LSB wordt gecombineerd tot nieuwe audio. Zet dan ook lock carrier 

aan in menu. Deze optie kan ook worden gecombineerd met Anti-Fading modes.
CW Shift Offset instellen tussen zend- en ontvangstfrequetie om zo alleen de 1 kHz te kunnen horen. Standaard: 600 (instellen op 1000 Hz)
Lock Carrier Alleen in AM en DSB modes, sta Sychrone AM toe wat ontvangst aanzienelijk verbetert ook als deze slecht en instabiel is.
AGC Auto Gain Control werkt realtime om te zorgen dat bij lage signalen een optimaal uitgangsnivo te krijgen en bij sterkte signalen vervorming te 

voorkomen. In WFM werkt AGC niet omdat dan amplitude altijd constant is. Bij NFM regelt de AGC de audio output waardoor signalen met zwakke 
audio toch goed hoorbaar zijn. Voor AM, SSB, CW en RAW werkt AGC altijd op de smalbandige IF.

Use hang: kan soms handig zijn om aan te zetten bij SSB en Morse signalen
Threshold: drempel waaronder signalen niet meer worden versterkt. Normaal -50
Decay: reactietijd, hoge waarde vertraagt interventie, lage waarden kunnen hinderlijke geluidseffecten tot gevolg hebben. Normaal 500
Slope: Versterkingscorrectie. Normaal 0

Layout opslaan Je kan ingestelde layout bewaren om later opnieuw te laden / wel altijd .layout.xml laten staan anders werkt het laden niet
10 MHz bandbreedte Bij 10 MHz bandbreedte kan signaal sneller overstuurt worden, gain moet dan altijd worden teruggeregeld.
Online servers Kies bij source voor AIRSPY Server Netwerk en copieer daar het adres van een server. URL: https://airspy.com/directory/

IN BASISVERSIE SDR#

Bandplan Bandplan is aan te passen door bandplan.xml te wijzigen. Je kan ook mode, step en kleur zelf invoeren.
opbouw kleur: Transparantie (xx), R (xx), G (xx), B (xx). Transparantie 00 - 99 / kleuren 2 digits hexdecimal
modes: WFM, NFM, AM, USB, LSB, CW

Frequency Manager
(FreqMan)

Er zijn meerdere frequentie managers actief in SDR#, je moet FreqMan v1.1.7.1 en FrequencyScanner v2.2.13.0 hebben.
- XML frequenties C:\SDRSharp\bin\frequencies.xml / XML naar Scanranges C:\SDRSharp\bin\scanner_entryes.xml
- Je kan ook scangebieden opgeven en automatisch laten scannen.
- Settings: Show Names / Spectrum / Only current group

Navigation: Frequency Manager zit ook in de standaard versie van SDR# en kan de XML ook lezen / alleen weergave is simpeler met blokjes. Je moet 
wel de aparte plugin FreqMan erbij zetten om betere weergave en scan opties te krijgen.

Voordeel is dat FreqMan & Scanner zelfde xml gebruikt als FMS-Frequency Manager Suite zodat alle data uitwisselbaar is (FrequentieSuite werkte niet 
goed)

Frequency Scanner
(van de maker van FreqMan) Scannen van frequentiegebieden met o.a. mogelijkheid om automatisch gevonden frequenties op te slaan.



Baseband recorder
(IQ record)

Opnemen met Baseband Recorder / Max 3 MHz opnemen / gebruik WAV FULL 16 bit (uitwisselbaar met SDRUno) / afspelen via play - Source Baseband 
File Player / In bestandnaam staat de centerfrequentie (let op naam niet aanpassen anders weet SDR# middenfrequentie niet meer)

Met Baseband File Player (Source paneel) kun je ook SDRUno bestanden met bandbreedte van 10 MHz afspelen / Ook SDR++ bestanden worden 
ondersteund.

NTFS formatering SD Card: Als je SD Card formateert als NTFS dan heb je de mogelijkheid om bestanden tot 16 TB op te slaan. FAT heeft een beperking 
van max 4 GB voor 1 bestand. 

Baseband File Player Om IQ opnames af te spelen. Je kan scherm groter maken of op apart scherm zetten zodat je beter overzicht hebt.
Config: Contrast op -20 / Show real time / Enable frequency cotrol / Loop AAN / FFT resolution 16384

Audio recorder Opnemen van audiobestanden (stereo / 16 bit PCM)
AM Co-Channel Canceller
FM Co-Channel Canceller

Voor het wegfilteren van interferentie veroorzaakt door een naastgelegen frequentie en soms zelfs een zender op zelfde frequentie.

Signal Diagnostics Het meten van het signaal in dB (schaal y balk), sourche Filtered LF, druk op reset om telkens juiste meting te krijgen

EXTRA PLUGINS

Tetra demodulator In plugin zet onder config Disable AFC (automatic frequency control) / groepen staan vermeld onder Net Info.
DSD Interface Instellingen SDR#: Audio > Output MME Cable Input / Filter audio UIT / DSD Interface > Audio Device MME Cable Input 

Instellingen DSD: DSD Path koppelen aan SDSPlus.exe / Output devicenummer instellen + channel mono / Decoderopties op AUTO of op direct wat je 
wilt decoderen (werkt sneller) / Create Command Line
- Door Enable aux output AAN te zetten en outputlevel laag te zetten, kun je meeluisteren naar audio voor de decodering.
- DSD scherm geeft aan of het VOICE of DATA is wat verzonden wordt en ook de Talkgroup wordt weergegeven.

CTCSS en DSC decoder Decoderen van tonen die meegestuurd worden met een analoog signaal.
RTL_433 Decoderen packets van sensoren meestal op 433,92, 315 MHz, 345 MHz, 868 MHz (SRD)  en  915 MHz (ISM bands)

INSTELLINGEN:
AM of NFM geeft meestal beste resultaten / Kies voor List Devices om alleen 1 lijst te krijgen met ontvangen devices. Na starten wordt als voor List 
Messages wordt gekozen voor ieder device een apart venster met specifieke kolommen geopend.
Zet bandbreedte op bv 500 kHz, de plugin kijkt zelf breder over de band naar ontvangen data (AM werkt meestal beste)

WERKING:
Modulatietechniek is vaak AM of on-off keying / Er worden ook veel eigen communicatieprotcollen gebruikt / 868 MHz vaak voor draadloze 
alarmsystemen gebruikt, bereik 30 meter, snelheden tot 100kbit/s / Domotica zoals klik aan klik uit, zigbee en z-wave maar ook voor remote sensors, 
beveiliging, speelgoed en weerstations gebruikt / Programma onderscheunt meer dan 200 protcollen

Audio Processor Bij portofoons kan het handig zijn om een filter in te stellen tussen 300 en 3000 Hz om hoge ruisgeluiden te onderdrukken
PALSecam TV PAL en Secam TV signalen decoderen en weergeven



Level meter
(tot v1732)

S meter geeft wel nauwkeurig waarden aan alleen is instelbaar waardoor je geen goede referentie heb van de juiste waarde / Instellen van een 
basiswaarde moet gebeuren in het XML bestand (standaard staat deze op Rate 30, Max -49 en Min -84).
- Rate = snelheid van de beweging / Min = onderwaarde in dB / Max = bovenwaarde in dB
- Goede startwaarde is Rate 1 / Max -10 / Min -75

ListenInfo HF ListenInfo HF geeft actuele informatie over zenders op bepaalde frequentie (realtime). Kan diverse databases laden zoals EIBI maar ook de XML van 
frequentiemanager kan ingelezen worden. Nadeel dat alle info altijd in beeld blijft staan en kan soms erg druk zijn.

SimpleDMR/SimpeDPMR/
SimpleAPCO

Simpele plugin om DMR, PDMR en APCO signalen te decoderen. Werkt niet altijd even goed, DMR dia DSD+ gaat meestal beter.

CSVUserlistBrowser (extern) Standalone applicatie die kan communiceren met SDR#. Direct vanuit allerlei databases klikken om SDR# in te stellen en in Trackmodes laat software 
direct zien wat er op die frequentie te horen is. Werkte niet met versie 1732.

DReaM DRM (extern) Laat audio via VAC lopen en zet SDR# op USB dan werkt decoderen het beste. Dream is een standalone applicatie.

RDSlogger (werkte niet goed) Scans FM band en slaat alle ontvangen RDS op in logfile, maar werkte niet goed.

RDS SPY NOG NIET WERKEND GEKREGEN
Config Audio via VAC 192 kHz

SDRUNO

Memorybanks In Calc csv opslaan als s1b bestand, filterinstellingen bewerken aan (Unicode UTF-16), veldscheiding komma, tekenreeks geen teken / copieer alles via 
klembord zodat vreemde opmaaktekens eruit zijn anders leest SDRUno frequentie niet goed uit / soms werkt het niet dan eerste rij vanuit DRSuno 
kanaal toevoegen.
Kolom UTC kun je ook gebruiken voor andere gegevens zoals zenderlocatie / SubM, Filter, Port, S en Mode overnemen van oude bestand
VANUIT ELAD OMZETTEN: Beste is om uit programma zelf (via de knop MEM) alle gegevens te copieren dan staat freq gelijk in juiste formaat. In 
SDRUno werkt het dan alleen de plugin FRAN geeft wel een error

IF Mode Low IF: wordt meest gebruikt.
Zero IF

Standaardsetting SR 5 MHz / Input Level Display GAIN /

CW instellen Toon draaggolf hoorbaar maken door op control+klik muis ergens tussen de 600 en 1000 Hz te klikken / bij RTTY en SITOR op 1500 Hz
In ontvanger ook CWPK en filter op 150 dan is morse beter hoorbaar

VAC meeluisteren SDRUno heeft geen aparte uitgang naar VAC, daarom hoofdkanaal via VAC laten lopen als decodeerprogramma draait. Meeluisteren kan door optie 
aan te zetten via Geluid > Eigenschappen > Luisteren > Naar dit apparaat luisteren

Virtuele Com Met programma com0com 2 COM poorten aanmaken voor SDRuno en externe software. SDRuno is compatible met Kenwood TS480.

DX Cluster Plugin voor zendamateurs / Werkt alleen als geldige call wordt gebruikt / Cluster: dxc.pi4cc.nl:8000 / Responce: dxspider

Plugins install DLL copieren in de map van communityplagins, die staat meestal onder: C:\Program Files (x86)\SDRplay\SDRuno\Plugins
Soms staan DLL's ook nog onder gebruikers/documenten maar dit werkt niet altijd goed bij de nieuwe versies.

https://www.google.com/url?q=http://dxc.pi4cc.nl:8000/&sa=D&source=editors&ust=1686384314841440&usg=AOvVaw0kmygSRBOLoV7mUn54DkzO


Plugin FRAN Je kan SWSkeds file uit map CommunityPlugins laden en dan kiezen uit bv HFCC of EiBi database. Zenders worden dan getoond. 
Ook eigen geheugenbanks kunnen geladen worden (alleen dan kolommen wel goed in tact laten dus geen afwijkende info plaatsen)

Echt overzichtelijk is deze plugin niet, frequentiemanager in SDR# is veel gebruiksvriendelijker
Plugin Cloudmarkers Geef op bepaalde frequentie aan wat daarop wordt uitgezonden, input komt van andere gebruikers (werkt niet)

Plugin ADSB Plugin stemt automatisch af op 1090 MHz en geeft in lijst alle ontvangen vliegtuigen. Plugin werkt samen met programma VirtualRadar waarmee 
vliegtuigen ook op een kaart worden getoond. Open VirtualRadar en klik op de URL in midden van scherm om naar browserpagina te gaan.

Plugin DAB Om audio af te spelen moet de Faad2 dll geplaatst worden in de map windows\SysWOW64

Record IO / Afspelen IO Zet in MAIN SR op 10 MHz, open Scheduler en start met opnemen. Dan wordt 10 Mhz IQ opgenomen in Wave bestand. SDRUno kan WAV FULL van 
SDR# ook afspelen. Wave bestanden van SDR++ kunnen in SDRUno worden afgespeeld

Scheduler Automatisch instellen dat bepaalde frequentiegebieden moeten worden opgenomen. Je kan kiezen voor alleen play, IQ opnames of scan van kanalen.

Middengolf in nacht opnemen: stel in ieder uur 4 minuten opnemen (dat is dan 1 bestand) / zet middenfrequentie vooraf op circa 1000 MHz en 2 MB 
bandbreedte. Let op de genoemde tijd is de UTC tijd
- Stel tijd in op 1 minuten voor hele uur omdat je dan vaak nieuws ID meepakt. 
- FUNCTION: IQ Record
- Event End: No end date
- Event Recurrence: Every hour(s)

SDRCONNECT

Algemeen Programma is nog erg basis met weinig opties. Maar wel versie voor Linux en Adroid (volgt later)
WERKT NIET GOED! NA INSTALLEREN WERKTE SDRUNO EN SDR# NIET MEER SAMEN MET SDRPLAY

SDRconnect Via CommandLine moet programma SDRconnect worden gestart : via 
cd C:\Program Files\Adrplay\SDRconnect
.\SDRconnect --server
--help om commando's op te vragen / poort 50000 / Keuze uit IQ (raw data, grote bandbreedte en Audio (via internet, minder bandbreedte)

MALAHIT DSP2

Display Om frequentie vast te zetten druk hou de frequentie afstemknop eventjes ingedrukt



RADIO Hi-Z ingang gebruiken voor draadantennes en andere antennes met hogere impedatie (alleen HF). De andere ingang is 50 Ohm.
Preamp versterkt het signaal maar geeft ook meer ruis. Op HF kan het ook tot oversturing leiden van zenders. Uit werkt vaak het beste.
PGA BST om oversturing te voorkomen als naar een erg sterk signaal wordt geluisterd. Normaal UIT
RF GAIN: standaard op 4, bij zwak signaal kan het werken te verhogen, als er veel ruis of verstoring is dan juist verlagen, soms tot nul (HF vaak > 10)
LNA/MIX UP GR & MIX GR: kan soms helpen om hele sterke signalen te verzwakken
EMI Reduction zet deze optie aan als er veel spikes ontstaan door interferentie van de display. Daarna langer vinger ergens op houden.
F correct / Sm correct: correctie van frequentie en signaalmeter
NCO: bij zoeken over de band blijft ontvangen signaal in midden of blijft band vast staan en beweeg je ontvangen signaal over de band
Activity timer: schakel apparaat na bepaalde tijd uit.
PRE Gain: correctie van de S meter als de PREAMP aanstaat en signaalmeter eigenlijk niet meer goede signaal aangeeft

AUDIO NB: Noise Blanking: Onderdrukken van ruis op de ingang van de audio. Threshold niet onder de 3 zetten.
AGC: Automatisch Gain Control: Volume automatisch aanpassen, 4 modes beschikbaar.. Normaal is Middle prima.
FILTER: Er zijn drie filters in te stellen, handig voor KG om narrow high fre op 2500 Hz te zetten.
ANF: Automatic Notch Filter om de carrier toon bij USB en LSB te onderdrukken.

VISUAL WF Gamma: Schakel tussen verschillende kleurschema's voor waterval beeld. Normaal classic
WF Gain: een hoger getal laat in de waterval meer details zien. Normaal 0 dB
WF Delay: de snelheid van de waterval. Normaal 1
FFT Color: de kleur van het panorama beeld. Normaal Yellow
FFT ave: aantal samples dat getoond worden in panorama beeld (normaal 70)
FFT fill: vul het panoramabeeld aan de onderkant
FFT RGRD: toon een grid
Pan percent: verhouding tussen de weergave van panoramabeeld en waterval. (normaal 70)

MODE AM: Als AM gekozen wordt kan MAG (klassieke AM), Synchronized AM, AM lower side band en AM upper side band worden gekozen
DSB: Dual Sideband AM icm LSB en USB. Kiest automatisch de sideband met hoogste signaal
CW: werkt i.c.m. LSB en USB en zorgt dat bandbreedte nog maar 1 kHz is.
CW DEC: Decoder van morse,wordt direct op display getoond. Min SNR op tenminste 29 zetten voor beste decoder gevoeligheid

BAND Memory slot: door langer in te drukken kom je in de settings om per memoryslot de SQL in te stellen en om aan te geven of dit kanaal in de scan mee 
moet lopen. Een andere frequentie of modes opslaan werkt simpel, zet ontvanger op juiste frequentie, modes e.d. en ga dan naar BAND en hoe 
gewenste kanaal waar je kanaal wil opslaan ingedrukt. Na opslaan van kanaal staat de nieuwe gegevens erin.

Band Monitoring: Hiermee kunnen alle 50 opgeslagen memory slots worden gescand. Ook hier kan skip, time out en SQL worden ingesteld per kanaal. 
Let op je stelt het hier niet apart in maar dit zijn de kanalen die je al eerder had geprogrammeerd.

Submonitor: Je kan vier aparte sets maken die specifiek bepaalde kanalen scans b.v. enkele portofoonkanalen.
Panorama schermbreedte Aan te passen door in de waterval te klikken, je kan schakelen tussen 48, 96 en 192 kHz
FM ONTVANGST Je kan een FM Retro Scale en MPX opvragen door op waterval te klikken



Connectie PC Als USB wordt aangesloten dan komen er drie nieuwe USB devices beschikbaar. 
- Malahit RX: Die is een audio imput die op de normale manier ook door de PC verwerkt kan worden.
- Malahit IQ: IQ signaal van complete 192 kHz bandbreedte die gelezen kan worden door HDSDR, SDR++ en SDR#
- Malahit CAT: Het aansturen van de Malahit via de PC, de commandset is gelijk aan de Kenwood KS-480

(dit deel niet echt werkend gekregen - maar ook niet echt van belang omdat Malahit toch standalone wordt  gebruikt)

CHRIP Programmeersoftware voor vele types portofoons
csv Als je nieuw doet krijg je een standaard indeling en kun je opslaan in csv formaat. Handig om alle losse onderdelen ook los te beheren in kleine lijsten.

Importeren Chirp kan ook files lezen van o.a. Kemwood en Yaesu FT3

SDRTrunk

Installatie In map staan instructievideo's hoe programma en JAVA te installeren en hoe je trunk.bat moet aanpassen / welk werkend gekregen met SDRplaydx 
alleen niets kunnen decoderen, ook omdat alles erg op USA was gericht in de instructievideo. Later nog eens naar kijken.

Rs41 Tracker v2.4

Config Klik op tandwiel om instellingen te doen. Belangrijk is dat eigen coordinaten goed staat en Callsign zodat data kan worden doorgegeven.
- Audio: Cable Output / Maps: OpenStreepMap, online mode map, Autosave maps, set home locatie en vul coordinaten en hoogte mast in.
- Meas Units: km/u / Sondehub: Enable SondeHun interface, Callsign invullen en Upload Home Position aanvinken

Werking In bovenste balk bij Sondehub is de data te zien die via internet binnenkomt over de sondes., eigen positie wordt ook getoond op de kaart / Druk om 
playtoets bij Deoding om continu coderen via VAC te starten / In de balk links is te zien als een signaal gedecodeerd kan worden o.a. Signal Prcessing en 
GPS Time lichten dan op / In rechterbalk is af te lezen wat de sonde voor data doorstuurt, ook de afstand vanaf home naar sonde is hier af te lezen

Uitgelezen data RS41 geeft veel extra data zoals voltage batterij, frequentie, temperatuur, locatie, hoogte, snelheid, richting, luchtdruk, luchtvochtigheid en dauwpunt
Aansturing audio Via VAC werkt via SDR++ maar ook SDR# alleen bandbreedte dan op maximaal 7 kHz zetten

Horus Elemetry GUI

Config Stel audiodevice in op VAC / Bij SondeHub callsign, coordinaten, hoogte antenne en gebruikte antenne en ontvanger invullen. SDR# zetten op CW (SSB 
werkt ook), bandbreedte op 2000. Let op de frequentie kan altijd iets afwijken. Druk op start om decoderen te starten, de flybag zendt eens per minuut 
de data door.

QRM KILLER

Lampjes Groene lampje is power en rode lampje is om aan te geven wanneer er uitgezonden worden (via PTT connector).



DSD+ Decoderen van o.a. DMR, D-Star
SDRuno Configuratie loopt via SDR# maar daarna kun je pakket wel opstarten en via VAC icm SDRuno gebruiken
LRRP LRRP = Location Request Response Protocol / Start DSD+ > LRRP.exe om coordinaten op kaart meer te geven (? = lijst commando's)
Aanpassen in/uit Gebruik Commandline, ga naar directory waar dsdplus staat cd [pad] en tik in: dsdplus -i2 -o1 (hierbij staat i2 voor ingang #2 en o2 voor uitgang #1 

(deze instellingen zie je staan als je normaal opstart)
NXDN NXDN4800 (Kenwood Nexedge en Icon IDAS) / NXDN9600 (Kenwood Nexedge)

MULTIPSK

Panoramic Gehele band ineens scannen / klik op rechter muisknop om help over modes te krijgen
Zenden TX Door op TX te klikken kan MultiPSK ook zelf in alle beschikbare ontvangstmodes ook zelf zenden.
Coderen > AIS Klik op Display all on GoogleEarth om de posities van de schepen weer te geven

YAND

Op stereomix zetten Op Stereo MIx zetten, via VAC werkte het niet / lijkt gevoeliger dan MultiPSK / schema klopt niet

QIRX DAB ontvanger, werkt op RTL stick, Airspy en SDRPlay
Handmatig opstarten Als audio niet start dan handmatig qirx_audio.exe opstarten / versie 4.0.1 vereist een licentie.
Autoscannen Met DAB Scanner kan continu alle kanalen worden gescand. Zet Auto Mode aan en optie Scan forever. In de lijst is zichtbaar hoevaak bepaald DAB 

pakket is ontvangen / LNA State 4 tot 6 AGC On (instellen door AGC uit te zetten en dan beste signaal te zoeken, meestal is dat 4).
Zenderlocaties Op tabje TII is te zien aan de hand van man/sub welke zenderlocaties ontvangen worden (iedere mast zend unieke code uit) / Show Alle entries 

aanzetten om alle locaties te zien (locatie wordt groen als zender ontvangen wordt)
Threshold Zet de threshold voldoende hoog omdat er anders ook zenderlocaties gelogd worden die niet juist zijn (default 0.253)
Resetten instellingen Als QIRX vreemd doet of delen van scherm niet ingevuld worden dan alle instellingen verwijderen gebruiker/AppData/Local/qirx4 (verborgen items 

aanzetten om deze mappen te kunnen zien)
Channel Impulse Response 
(CIR) 

 dat de relatieve vertragingen toont van een signaal dat verschillende paden heeft gevolgd op zijn weg naar de ontvangende antenne, of afkomstig is 
van verschillende zenders.

CIR spectrum Zet deze op Distance zodat je snel kan zien welke zender dichtbij en mogelijk het sterkste is.



SNR/MER en storingen De CNR zegt niet alles bij DAB, is combinatie van. De MER is betere indicatie of alle data ook daadwerkelijk gecodeerd kan worden. Soms kan een 
interferentie of storingen wel zorgen door goed signaal (SNR prima) maar toch een veel wegvallend signaal (MER laag). 
- Als een signaal bv portofoon het kanaal stoort dan wordt slechts een klein deel van de 1536 lijnen van het DAB spectrum verstoort en zal verder 
weinig last ervan ondervinden.
- Als er twee zenders op een kanaal zitten is dat zichtbaar aan minima in het spectrum (normaal moet signaal beetje vlak zijn aan bovenkant). De MER 
neemt dan in waarde af terwijl de SNR gewoon goed blijft, immers het signaal is verder prima.
- Als er heel veel zenders worden ontvangen dan kan signaal voldoende sterk zijn maar de MER toch slecht. Dit komt omdat zenders die meer dan 75 
km verwijderd zijn van elkaar (250 microseconden) elkaar interfereren en dus meer fouten opleveren.

Map met zenderdatabase users\[pcnaam]\AppData\Local\qirx4\Database

Qt-DAB DAB ontvanger, werkt op RTL stick, Airspy en SDRPlay
Algemeen Programma is wat lastig in gebruik door alle losse vensters. Logs toonde software goed, alleen niet alle Tii zenders en ook op de kaart werd maar 1 

transmitter getoond, wel dan met alle Mux die vanuit die zendmast werd uitgezonden.
Congururation and control save servive on exit / new tii detector / close without asking / clear scan / utc selector / epg automatic / save slides

alphabetically / vul de juiste coordinaten in (anders kun je http on niet oproepen om zenderkaart te tonen) / 
Scan monitor continous (continu scannen van alle kanalen)
SNR Belangrijkste signaalwaarde is de SNR om te noteren

AbracaDABra DAB ontvanger, werkt op RTL stick en Airspy
Export modes Standaard wordt programma in basismodes geopend, gericht op alleen luisteren naar zenders. ga naar settings > others om onder User Interface de 

Expert mode UI te activeren.
Tii Onder settings Transmitter Database updates en GPS coordinaten handmatig invoeren. De data komt dan FMlist. Daarna worden zenders op een kaart 

getoond.
Scantool De scantool scant doorlopend alle kanalen en geeft de zenders weer in lijst en kaart. Export is mogelijk naar een csv bestand. Kan in drie modes 

werken: snel (4s per ensemble waarbij zwakke stations mogelijk niet herkend worden), normaal (8s per ensemble) en Precise (15s per ensemble) 
waarbij ook zwakke zenders worden waargenomen. / Number of cycles op 0 (Inf) zodat doorlopend wordt gescand. 

KiwiSDR

Frequentie aanpasen Klik control of alt in spectrum om in band omhoog of omlaag te springen / klik h om alle sneltoetsen te krijgen.
Voorinstellingen Op label klikken om te laden met voorinstellingen

WSJT-X

 Kan Yeasu via CAT aansturen / stel in op USB 5 kHz als ontvanger dit toestaat

Shift en control om RX enTX frequentie in spectrumdiagram aan te passen



STORINGEN 

Grootste veroorzakers (90%) Power Line noise
- Rapsy sounds, pulsing, sputtering / breedbandige storing tot met 144 MHz (lagere amplitude bij hogere frequentie)

Led lighting and grow light, dimmers
- Is met goede filters op te lossen / frequentie herhaald in bepaalde intervallen 

Solar power PV Photovoltaic systems
- Frequency repeat at 200 kHz intervals / geen licht geen storing

Storingsbron zonnepanelen 1) Panelen worden in serie met elkaar verbonden om de gelijkstroom naar de omvormer te krijgen. Als dit met een enkele draad gebeurt dan vormt dit 
een ideale antenne om RFI signalen te verspreiden.  Dit soort loops zijn niet toegestaan, een betere methode is waarbij twee aders worden getwist 
waarna ze samen langs alle panelen lopen. Voedingskabels zender dan geen signaal uit doordat de stroomrichting in beide aders tegengesteld is 
waardoor de stralingen van de afzonderlijke kabels erlkaar opheffen.

 - Als een goede aardedraad ontbreekt is de montagerail niet geaard en kan dus brandgevaar opleveren.
- Getwiste kabels is al beter maar beste is een afgeschermde kabel maar bedrijven doen liever een lus om kosten op koper te besparen.

2) Omvormers moeten de gelijkspanning van de panelen omzetten naar een wisselspanning van 230V. Deze moet ook syncrhoon lopen met de 
sinusvormige spanning van de netbeheerder. De beste oplossing is een zuivere sinusomvormer. Gemodificeerde sinusomvormers produceren een 
soort blokvorm die eigenlijk bestaat uit oneinig veel sinusvormen die weer net zoveel harmonische signalen afgeven op je eigen 220V netwerk in huis. 
SMA omvormers werken altijd storingsvrij.

- Heel vaak wordt gewoon een niet geaard stopcontact op de zolder gebruikt om de spanning bij de meterkast te krijgen. 
- Voor de data overdracht (monitoren op app) is een wifi module de beste oplossing, vaak worden UTP kabel of slechtste oplossing een TP Link gebruikt. 
- Als UTP kabel wordt gebruikt moet voor de duurdere CAT6 of F/UTP afgeschermde kabel worden gekozen anders vormt de UTP kabel een antenne.
- TP Link is altijd een bron van storingen omdat alle data via het 220C stroomnet wordt verzonden (Methode Ziggo PowerLine).
- Er moeten aan de gelijkstroom (in) en wisselstroom (uit) kant krachtige filters worden geplaatst om HF en EMC stoorsignalen te onderdrukken.
3) Power Optimizers hebben de taak om te voorkomen dat als 1 paneel minder produceerd (bv omdat deze de schaduw komt  te liggen) de hele 
seriekring negatief wordt beinvloed en de opbrengst afneemt. Optimizers worden tussen elk paneel en de voedingskabel geschakeld en geven data 
door via hoogfrequentie signalen via diezelfde voedingskabel. In combinatie met punt 1 functuioneert de installatie ook nog eens als antenne.
- Er moeten in de aan- en afvoerleidingen krachtige filters worden geplaatst om HF en EMC stoorsignalen te onderdrukken.

NEN 1010 normen 1) Het brandvrij doorvoeren van de gelijkstroomkabels door het dak naar de omvormer

2) Het aarden van de dagrails door deze rechtstreeks door te verbinden met de aardaansluiting in de meterkast,

3) Het aansluiten van de omvormer op een aparte (gezekerde) groep in de meterkast.

Herkennen van storing De combinatie van een loop op het dak en omvormer/optimizer veroorzaken veel ruis, ratel en zogenaamde spikes die zich om de 100 kHz herhalen.
EMI Elektromagnetische Interferentie



RFI Radio-Frequency Interference
Link https://de-radio-amateur.nl/zonnepaneel-storingen

Link https://forums.qrz.com/index.php?threads/solar-power-and-rfi-do-this-test-even-if-you-dont-have-solar.681881/
Link https://www.youtube.com/watch?v=TtDJpq8UIGo

MILITAIRE SATELLIETEN 240 - 270 MHZ

Overzicht alle satellieten https://www.satellitenwelt.de/uhfmilsat.htm#Fltsatcom
Fleet Broadcast Decoder v0.5 https://www.r00t.cz/SW/FBR

Fleet Broadcast is a 16 channel 75Bd multiplex transmitted from SATCOM satellites on 250.450/550/650 MHz. Modulation is DBPSK 1200Bd, to receive 
it you need receiver with 2KHz filter and SSB mode. Channel #0 is used for synchronization, other channels are usually filled with pseudo-random 
crypted data. Sometimes KG84 messages are transmitted. So far no plaintext was ever seen on Fleet Broadcast... 

The Milstar satellites transmit a digital mode nicknamed the “waterdripper.”
Between 243.785 and 243.825 MHz it is visible in the spectrum.

Fleet Broadcast is a 16 channel 75Bd multiplex transmitted from SATCOM satellites on 250.450/550/650 MHz. Modulation is DBPSK 1200Bd.
Herkenbaar De satellieten zenden als ze niet worden aangestuurd altijd soort van ruis uit over de hele bandbreedte en die is zichtbaar in de SDR.

MODULATIE TECHNIEKEN

ASK Amplitude Shift Keying / USB
Site https://www.youtube.com/watch?v=qGwUOvErR8Q
Werking Als signaal hoge amplitude heeft is het een 1 en bij lage amplitude een 0

FSK-SYSTEMEN Frequency Shift Keying / USB
Werking De bitstand 0 en 1 worden uitgezonden via twee gemoduleerde tonen. Zendt alleen teksten.

Simpele vorm is Binary FSK (BFSK) / Space is altijd laagste freq en is de 0 / Mark is de hoogte freq en is de 1 / veel toegepast bv deuropeners
M(-ary) FSK heeft meerdere frequenties (MSDK) / 4FSK = 4 frequenties / ALE is 8FSK / DMR is 4FSK

Klinkt als Klinkt vaak als soort buzzer of krekel met constante of pulsende datastroom. 
FSK modes zijn herkenbaar aan de verschillende draaggolven (meer dan 2) als er data wordt uitgezonden
en klinkt als snelle wisseling van verschillende toonhoogtes.

https://de-radio-amateur.nl/zonnepaneel-storingen
https://forums.qrz.com/index.php?threads/solar-power-and-rfi-do-this-test-even-if-you-dont-have-solar.681881/
https://www.youtube.com/watch?v=TtDJpq8UIGo
https://www.satellitenwelt.de/uhfmilsat.htm#Fltsatcom
https://www.youtube.com/watch?v=qGwUOvErR8Q


Continu bitstream Onder de continu bitstream vallen o.a. ARQ, Baudot, Diplo (ITA-2 & 5), CIS, Pactor-FEC, Sitor-B (FEC)
Burst (puls) systemen Onder de burst (puls) systemen vallen o.a. ARQ6-90, CIS, G-TOR, Packet Radio AX.25, Pactor-1 ARQ, Sitor-A

De burst is nodig om de ontvangende kant een Automatic Request (ARQ) te laten doen.
LSB mode = reverse Ontvangen in de mode USB (bij LSB zijn mark en space omgekeerd en moet op decoder Reverse aanslaan!)
Site https://www.youtube.com/watch?v=qGwUOvErR8Q

MFSK-SYSTEMEN Multi Frequency Shift Keying / USB
Werking Lijkt op het FSK systeem, alleen wordt met meerdere gemolduleerde tonen gewerkt (van 6 tot wel 36 tonen).  Zendt alleen teksten.
Klinkt als Snelle opeenvolging van tonen met constante of pulsende datastroom. Zendt alleen teksten.
Continu bitstream Onder de continu bitstream vallen o.a. Coquelet, Crowd, DominoEX, MFSK8, MFSJ16, Olivia Hybrid MFSK, Piccolo (FEC)
Burst (puls) systemen Onder de burst (puls) systemen vallen o.a. Crowd36, Twinplex Sitor, UNID, Alcatel 801H

De burst is nodig om de ontvangende kant een Automatic Request (ARQ) te laten doen.
LSB mode = reverse Ontvangen in de mode USB (bij LSB zijn mark en space omgekeerd en moet op decoder Reverse aanslaan!)

PSK-SYSTEMEN Phase Shift Keying (BPSK / PSK) / USB
Werking Moduleren gebeurd door faseverschuiving. Bij fasemodulatie veranderd de richting van golf als o een 1 of 1 een 0 wordt. 

Als er geen data wordt verzonden dan zijn twee draaggolfen beschikbaar.
Bij hogere snelheden liggen de twee draaggolven verder uit elkaar. "Bepaal altijd eerst de bandbreedte en aantal draaggolven.

Klinkt als Knorrend geluid met constante of pulsende datastroom. Klinkt als grote brei aan allerlei tonen door elkaar. Zendt alleen teksten. 
Continu bitstream Onder de continu bitstream vallen o.a. Bul Diplo, Pactor-II FEC, BPSK, MT63, PSK220F, PSK31, PSK63
Burst (puls) systemen Onder de burst (puls) systemen vallen o.a. Codan, Clover, Pactor-II ARQ
LSB mode = reverse Ontvangen in de mode USB (bij LSB zijn mark en space omgekeerd en moet op decoder Reverse aanslaan!)
Site https://www.youtube.com/watch?v=qGwUOvErR8Q
 Amateurmodes / Er zijn heel veel modes van PSK / BPSK31 is meest gebruikt
Varianten BPSK/QPSK PSK63 = 160 Hz BW / Binary PSK (BPSK) gebruikt 2 fasepatronen en Quadrature PSK (QPSK) gebruikt 4 fasepatronen
BPSK10 BPSK10 is een simpele variant voor bv call
QAM Quadrature Amplitude Modulation is een combinatie van faseverschuiving en amplitudeverschillen.

FOUTCONTROLE (ARQ/FEC)

Werking ARQ is een manier van foutcontrole om te zorgen dat de verzonden data ook exact gelijk aankomt bij de ontvanger. Er worden 1 of meerdere 
controlebits (pariteitsbits) meegestuurd ter controle. Er zijn twee soorten:
- Foutherkennende codes: een ontvanger moet kunnen terugmelden, herhaling volgt net zolang tot het goed is.
- Foutcorrigeerde codes: de ontvanger moet fouten zelfstandig aanpassen, stelt hogere eisen aan controlebits want heruitzenden van data kan niet. 
Hieronder valt de methode FEC (Forward Error Correction).

https://www.youtube.com/watch?v=qGwUOvErR8Q
https://www.youtube.com/watch?v=qGwUOvErR8Q


Foutherkennende codes Een ontvanger moet kunnen terugmelden, herhaling volgt net zolang tot het goed is.
Foutcorrigeerde codes De ontvanger moet fouten zelfstandig aanpassen, stelt hogere eisen aan controlebits want heruitzenden van data kan niet. 

Hieronder valt de methode FEC (Forward Error Correction).

DIGITALE MODES - SCHEEPVAART

Intraship Verkeer via marifoon op eigen schip onderling
Zendvermogen laag vermogen (0,5 tot 1 watt) Nederlandse binnenwateren / hoog vermogen (6 - 25 watt) In buitenlanden en op zee

SITOR-A Ook bekend als AMTOR-A / ARQ (BURST) / 350 Hz / BW 350 Hz / 3 - 30 MHz / USB
Werking Twee draaggolfen met shift van ca. 170 Hz, wordt tekst mee verzonden, in MultiPSK selecteer de hoogste draaggolf.
Klinkt als Pulserende digitonen, klinkt rustig. Krekelgeluid, pulsende toon (ca 2 per sec.), 
Info Basis was TOR (Telex over Radio) uitgevonden door Nederlandse PTT

SITOR-B / NAVTEX / AMTOR SImplex Teletype Over Radio / FEC (CONTINU) / USB / BW 350 Hz / 3 - 30 MHz

Indentificatie In eerste regel van het bericht zit al het ID (bv WA50 wil zeggen ID = W en bericht 50)
Werking Twee draaggolfen met shift van ca. 170 Hz, wordt tekst mee verzonden, in MultiPSK selecteer Amor FEC-Navtec en de hoogste draaggolf.

Center 1500 Hz / Shift 170 Hz / Snelheid 100 Bd
 Internationale automatische radioltelexdienst met maritieme veiligheidsberichten (meteo waarschuwingen)
Klinkt als Krekelgeluid, continu aanwezig met pulsende toon (circa 4 per sec).
YAND Let op de ID's in programma kloppen vaak niet, altijd checken met https://www.dxinfocentre.com/navtex.htm
Info Basis was TOR (Telex over Radio) uitgevonden door Nederlandse PTT

PACTOR I USB / ARQ (BURST) / BW 300 Hz / 3 - 30 MHz
Gebruikt voor Wordt voor mailverkeer mariniers gebruikt / Zendamateurs gebruiken het ook voor Winlink
Werking Krekelgeluid met korte stiltes, twee draaggolven met shift van ca. 200 Hz, worden blokken met tekst mee verzonden, in MultiPSK selecteer Pactor1 en 

de hoogste draaggolf.
Klinkt als Serie van tonen met korte onderbreking

AIS Automatic Indentification System / BW 25 kHz / NFM
AIS Kanalen De meeste zeeschepen dienen sinds enige tijd uitgerust te zijn met AIS. Dit is een wereldwijd gebruikt transpondersysteem dat in de marifoonband 

werkt. De gebruikte frequenties zijn 161.975 en 162.025 MHz (marifoonkanalen 87B en 88B, omgedoopt in AIS1 en AIS2). Dit is de ontvangstfrequentie 
volgens de Brussel overeenkomst (zenden op 157,375 en 157,425). In de Bassel overeenkomst wordt op 157,375 en 157,425 in simplex gewerkt.



Werking Een AIS-zender op een schip zendt met regelmatige tussenpozen de positie, koers, snelheid en MMSI (het unieke maritieme identificatienummer) uit. 
Deze gegevens worden ontvangen door schepen in de nabijheid. Deze kunnen de gegevens automatisch laten plotten op een beeldscherm of 
radarscherm. Het bereik van AIS is ongeveer 30-40 km. Iedere 2 - 10 seconden worden uitgezonden.

Klinkt als AIS is te horen als heel korte veranderingen in de ruis.

ATIS Automatic Transmitter Identification
Werking Wordt meegestuurd met marifoon na ieder gesprek om schepen uit elkaar te kunnen houden via uniek scheepsnummer / wordt door RDI verstrekt.
MultiPSK Om ATIS codes te ontvangen op ATIS zetten en de knop VHF/ATIS aanzetten (kan ook GMDSS DSC ontvangen op 156.525 MHz)
Opbouw code Roepnaam schip PI4019 = ATIS- code 9244094019

9 altijd / 244 = Nederland / 09 = Negende letter alfabet I / 4019 cijfers van de roepnaam
Info link https://www.vaarbewijzen.nl/marifoon/atis-code/

RADIOFAX / WEFAX BW 3000 Hz / CW / 3 MHz - 30 MHz
MultiPSK Kaart ontvangen USB (LSB dan Reverse) / officieel CW maar met USB of LSB vaak beter plaatje / F1C-120 weather fax = 120 is Scanning Speed Choice
Voorbeeldzenders http://qrg.globaltuners.com/?q=Northwood%2C+UK
Afstemmen Draaggolf op 1000 Hz / Wit + 425 Hz / Zwart - 425 Hz

Je stemt af op bovenste draaggolf (dit is 1425 Hz), dit is het wit in het plaatje (zwart zit 850 Hz lager). Als kaart en verkeerd om uit komt dan op Reverse 
zetten dan wordt zwart en wit omgedraaid.

Wefax MultiPSK geeft ook aan waar de satellieten zich bevinden / zet programma op APT
WXtoImg

(niet werkend, wel decoderen 
maar geen afbeelding die juist 
is)

1) Options > Ground Station Location: Vul grote plaats in de buurt in, die herkent systeem beter
2) Help > Enter Upgrade key: Kevin Schuchmann / Key: CGHZ-PP9G-EAJZ-AWKK-NDNX / Eigen mailadres invullen 
3) File > Satellite Pass List (geeft overzicht van momenten dat satelliet overkomt
4) Options > Recording Options: Cable output VAC, sample rate 22050, receiver band rate 57600
5) SDRPlay op WFM, badbreedte 60k en output naar VAC
6) Enhancemenys > MSA Multispectral analysis
7) Options > Resync UIT en show All AAN
8) File > Record > Create images AAN en Auto Record AAN (software gaat dan wachten op input)

DSC / GMDSS / ATIS USB / BW 350 Hz / 2.177 - 156.525 MHz
 Global Maritime Distress and Safety System's Digital Selective Calling System in een maritiem protocol die FSK gebruikt en erg op SITOR lijkt. Het 

systeem lijkt op een pagingsysteem. Zendt alleen codes uit die in de ontvanger worden gekoppeld aan bepaalde boodschappen waarop b.v. een 
schipper dan actie kan ondernemen door contact op te nemen via spraak. Ook kan in 1x een noodbericht gestuurd worden.

Uitzendfrequenties In YADD staan alle uitzendfrequenties vermeld
SDRplay Digital / 4000 k / NBOFF / FAST
MultiPSK Reception: normal / instellen op hoogste draaggolf
Let op! Alleen de kuststations loggen en niet de signalen vanuit de schepen

https://www.vaarbewijzen.nl/marifoon/atis-code/
http://qrg.globaltuners.com/?q=Northwood%2C+UK


DIGITALE MODES - LUCHTVAART
Afkortingen / vertalingen Approach = naderend verkeer / Departures: vertrekkend verkeer / Arrivals = aankomsten / RWY = runway / Delivery = levering
ICAO code landen EH = Nederland / EB = Belgie / LF = Frankrijk / EL = Luxemburg / ET = Duitsland / EG = Groot-Britannie / EK = Denemarken / EI = Ierland
ICAO code luchthavens EHAM = Amsterdam / EHEH = EIndhoven
IATA code luchthavens AMS = Amsterdam / EIN = Eindhoven

Schiphol baanbenamingen

ATIS Automatic Terminal Information Service / automatisch bericht dat continu wordt uitgezonden met weersgesteldheid op vliegveld en operationele 
bijzonderheden

Volmet Weerinformatie vliegvelden / komt uit  French woorden "vol" (vlucht) and "météo" (weer)



TMA Terminal Control Area / het controleren van alle vliegtuigen die naderen of vertrekken van vliegvelden en vliegtuigen die alleen overvliegen in een 
bepaald luchtruim

FIC Flight Informatie Center / verkeer in de omgeving
UAC Upper Area Control Center / het controleren van vliegverkeer in hogere luchtwegen
ATC Air Traffic Control
ACC Area Control Center / begeleiding van burgerluchtvaartverkeer
Mil ATCC Military Air Traffic Control Center
Mil CAPP Military Centralized Approach / Begeleiding militair verkeer
RAPCON Radar APproach CONtrol / RAPCON controleert de aanvlieg- en vertrekroutes en houdt het verkeer rond de bases in het oog. Verder vallen de Arrival 

controllers, zoals Eindhoven Arrival, onder de diverse RAPCONs. De taak van de Arrival controller is feitelijk het voor de baan krijgen van aankomend 
verkeer nadat het door RAPCON of DutchMil wordt aangeleverd. Eindhoven Arrival krijgt verkeer aangeleverd van RAPCON South of (indien RAPCON 
niet online) Dutchmil en begeleidt dit naar de final approach course. Arrival handelt geen vertrekkend verkeer af, dit gaat direct van Tower naar 
RAPCON of naar Dutchmil indien RAPCON niet online is. Arrival wordt alleen ingezet tijdens events.

RAPCON kunnen we onderverdelen in:
- RAPCON North: EHLW-Leeuwarden en EHKD-De Kooi
- RAPCON East: EHTW-Twenthe
- RAPCON South: EHEH-Eindhoven, EHVK-Volkel en EHGR-Gilze rijen
- RAPCON West: EHWO-Woensdrecht

RAPCON Posities:
Naam / Callsign / Frequentie /Velden
- RAPCON North /EHLW_R_APP / 132.025 / EHLW, EHKD
- RAPCON East / EHTW_R_APP / EHTW
- RAPCON South / EHVK_R_APP / 123.175 / EHVK, EHEH, EHGR
- RAPCON West / EHWO_R_APP /   123.575 / EHWO              



Frequentieraster 8,33 kHz Omdat er te weinig kanalen beschikbaar waren in het 25 kHz raster is men overgestapt naar het 8,33 kHz raster. Er passen dan drie kanalen in een 
gebied waar er eerst maar 1 kanaal mogelijk was. Omdat de exacte frequentie daardoor 5 cijfers achter de komma werd (b.v. 121,69166) en lastig te 
communiceren is internationaal afgesproken om op de apparatuur en in tabellen altijd als weergave afgerond naar de dichtbijzijnde veelvoud van 5 
KHz (dus hier 121,690). Let op de zendfrequentie is wel gewoon 121,69166 MHz). Bandbreedte bij 8,33 KHz is 6 tot 8 kHz.

118.000000 MHz = display 118,005
118.008333 MHz = display 118,010
118,016666 MHz = display 118,015
118,025000 MHz = display 118,030
118,033333 MHz = display 118,035
118,041666 MHz = display 118,040
118,050000 MHz = display 118,055

118,058333 MHz = display 118,060
118,066666 MHz = display 118,065
118,075000 MHz = display 118,080
118,083333 MHz = display 118,085
118,091666 MHz = display 118,090
118,100000 MHz = display 118,105

LET OP! ZENDERS WIJKEN SOMS BEST WEL IETS AF VAN EXACTE FREQUENTIE (b.v. 134.375 Amsterdam ACC Radar Sector 1 Noord)

HFDL OOK HF-ACARS - ARINC 753 - ARINC 635 - HF DATALINK / USB / BW 2,4 kHz / 2.9 - 22 MHz
Uitleg Om korte berichten (bv weerberichten en ACARS) over lange afstand te kunnen verzenden tussen vliegtuigen en grondstations. Ook kan een 

grondstation technische gegevens opvragen, veel info wordt automatisch verzonden vanuit vliegtuig zoals positie, vliegtuig ID, aankomsttijd of 
meterologische waarnemingen. Signaal start altijd pieptoon.op 1440 Hz (in MultiPSK kun je dan ook juiste frequentie bepalen - staat ook in kopregel)

Technisch Hulpdraaggolf: 1440 Hz / data verzonden met 300, 600, 1200 of 1800 bps
MultiPSK Pro . HFDL / Zorg dat SPDU, MPDU, LPDU en HFNPDU aan staan / In berichten staat altijd de ID van verzendend station
Sorcerer PSK >/ ARINC635 (ontvangst redelijk eenvoudig alle berichten)
Let op! Je ontvangst heel vaak signalen vanaf vliegtuigen naar een grondstation maar niet altijd het grondstation zelf. Daarom geen SINPO invullen, alleen dat 

er iets verzonden is vanuit vliegtuig naar een bepaald grondstation (dit is te zien in de gedecodeerde berichten).

ACARS Aircraft Communications Addressing and Reporting System / AM / BW 5 kHz / 129 - 137 MHz



Digitaal datalinksysteem voor de verzending van korte berichten tussen  vliegtuigen en grondstations via luchtbandradio of satelliet. ARINC 
ontwikkelde systeem in 1978 met behulp van Telex formaat.

VDL2 Very High Frequency (V) Digital Link (DL) Mode 2 / USB of Digital / BW 25 KHz / 117,975 MHz - 137 MHz

Is opvolger van ACARS / Digitaal berichtenverkeer tussen vliegtuigen en grondstations (ook meteo informatie)
Decoderen SDR Console Gebruik SDR Console omdat de Wide band USB moet kunnen ontvangen. Zet bandbreedte op 24 KHz en stem beetje in midden af. Stuur audio via VAC. 

Als het goed is zouden berichten moeten verschijnen, is dat niet zo dan I/Q component omdraaien.
- Go-knop: zet aan om MultiPSK test te laten doen, hoe zuiver de radio is afgestemd (-150Hz betekent dat radio 150Hz te laag staat).
- D geeft aan hoeveel berichten zijn ontvangen en hoeveel programma kon decoderen.
- Zet knop Expl./Meteo aan om ook meteoberichten te kunnen ontvangen.

Decoderen SDR Play Gebruik VAC en zet SDRPlay op Digital of IQ Out

ADS-B Automatic Dependent Surveillance-Broadcast / 1090 MHz / BW 50 kHz /  PPM Modulatie
Uitleg Moderne vliegtuigen hebben satellietnavigatie en GPS en weten zo zelf hun positie het beste, ADS-B zendt iedere seconde deze data uit voor 

verkeerleiding en andere vliegtuigen (in cockpit ziet men welke vliegtuigen in de buurt zijn).
Software Coderen met SDRUno plugin ADS-B en samen met Virtual Radar is vliegtuigpositie zichtbaar te maken

ALE / MIL-STD-144-141A BW 2 kHz / USB / 3 - 28 MHz
A141A (ALE) Continu tonen met variatie in tonen en licht knorrend geluid eronderdoor, klinkt als sirene onderwater.

Dit is de normale manier van ALE ontvangen (ID werkt zoals telefoonnummer, worden berichten mee verzonden)
BW 400 Hz / amateurversie van 2G ALE / 1806 - 144.163 MHz / ook bij emergency gebruikt

2G ALE / MIL-STD-144-141A 2G ALE decoderen met 141A ALE / Staat ook bekend als MIL-STD-144-141A of MIL-STD-144-141B
Klinkt als 8 tonen die naast elkaar worden uitrgezonden op pulsende snelle manier

ARCOTEL ALE Pulsend stilte en korte datastroom, snelheid: 1800 en 2400baud

DIGITALE MODES - AMATEURS

TETRA TErrestrial TRunked RAdio / 4 tijdslots / BW 25 KHz
C2000 C2000 Nederland gebruikt een extra encryptielaag (TEA2 protocol) waardoor afluisteren niet gaat, in Belgie/Duitsland kan dat wel.
Termen DMO = direct mode communicatie /  TMO = Trunked Mode Operation (repeater voor 'normaal' verkeer)

MCC - Landcode (NL = 204) / MNC = Mobile Netwerk Codes (ID netwerk) / GSSI = Groepcode / ISSI - Gebruikers ID)
LA = Location Area / CC = Color Code (getal tussen 0 t/m 15 die regelt dat ontvanger naar digitale signaal gaat luisteren)

Decoderen Met SDR# / in config Disable AFC (Automatic Frequency Control)

DMR Digital Mobiele Radio / 2 tijdslots / BW 12,5 kHz



MultiPSK In MultiPSK wordt code gegeven wie met wie verbinding maakt (SDRUno via VAC anders werkt het niet) - CC is af te lezen in midden (ook al kan bericnt 
niet gecodeerd worden)

DSD+ Audio meeluisteren is soms moeizaam maar de data en CC info op beide kanalen wordt wel getoond

DMR wordt vooral gebruikt bij professionele commerciele netwerken wereldwijd / heeft lage complexiteit
Standaarden Drie standaarden: Tier 1 - simplex licentievrij PMR446 (amper gebruikt) / Tier 2 - zendamateurs simplex, duplex en repeaters  / Tier 3: professioneel 

gebruik, met trunking
Termen Tijdslot (TS):DMR gebruikt 2 tijdslots waardoor gelijktijdig 2 gesprekken gevoerd kunnen worden op 1 kanaal (1 slot is 6,25 kHz breed)

Colour Code (CC): getal tussen 0 t/m 15 die regelt dat ontvanger naar digitale signaal gaat luisteren
Talkgroups (TG): (groepsgesprek) of DMR ID (prive gesprekken - weinig door amateurs gebruikt)
RID = Radio ID (unieke ID om de gebruiker van de porto te kunnen herkennen)

DMR Simplex Gebruik dan CC 1, TS 1 en TG 99, dat wordt internationaal daarvoor gebruikt.
RAS Restricted Access to System / Speciale extra code in apparatuur van bedrijf om te voorkomen dat niet geautoriseerde apparatuur ook kan inloggen
Repeaters DMR kunnen je koppelen via repeaters door netwerken zoals Brandmeister (meest gebruikt), DMR-MARC en DMR+ / repeater heeft statische en 

dynamische gespreksgroepen
Eigen DMR ID Eigen DMR ID aanvragen via https://www.radioid.net/ (in Nederland begint ID altijd met 204)

Naast de mogelijkheid om privé gesprekken te voeren kunnen ook noodoproepen, tekstberichten en GPS informatie als data worden gestuurd.
Codeplug Volledige programmering van een DMR apparaat incl. contacten en zones
Contacts 204 Nederland / 91 Wereld / 92 Europa / 922 Nederlands
Webinformatie https://www.pc5e.nl/info/dmr-techniek-voor-beginners

POC

Werking PTT over cellular / nieuwe type radiocommunicatie waarbij men niet rechtstreeks van toestel naar toestel zend en toch ook geen repeater nodig 
hebben, de verbinding gaat via een bestaand GSM netwerk waardoor ook het bereik onbeperkt is.

NXDN BW 6,25 kHz  (NXDN48) / 12,5 MHz (NXDN96)
Open standaard Open digitale standaard ontwikkeld door Icom en Kenwood / https://nxdn.n18.de/
Klinkt als Klinkt als soort ruis  / Kenwood gebruikt NEXEDGE en Icom IDAS (Icom Digital Advanced System)
RAN Bij logboek altijd RAN (Radio Acces Numbers) vermelden. 

C4FM/FUSION BW 16,0 kHz
Technisch Door Yaesu ontwikkelt digitaal voice/data protocol

P25 / APCO-25 BW 12,5 kHz

https://www.pc5e.nl/info/dmr-techniek-voor-beginners


Info Project25 (P25 of APCO-25) / Trunked radiostandaard ontwikkeld voor gebruik door openbare veiligheidsorganisatie wereldwijd / Ondersteund 
gecodeerde spraak / Bestaat als sinds 2010 / Is beetje de Amerikaanse tegenhanger van TETRA

Fase 1 FDMA 9600 bps voor spraak of data / Fase 1 kan C4FM (continu FM met 4 niveas) of CQPSK modulatie gebruiken
Fase 2 TDMA 2 slots systeem over 12,5 kHz bandbreedte / Door motorolla geleverd / alleen toegepast bij trunkingsystemen / TDMA (T staat door Time dus voor 

bepaalde tijd wordt een frequentie toegewezen en kun je dus meer gebruikers verbindingen gelijkertijd maken)
NAC Driecijferig hexadecimale netwerktoegangscode (NAC) en vergelijkbaar met CTCSS en DCS zodat radio het juiste signaal ontvangt (dus geen landelijk ID 

zoals bij Tetra en DMR van toepassing is)

D-STAR Digital Smart Technologies for Amateur Radio / BW 6,25 kHz
Technisch Door Kenwood ontwikkelt digitaal voice/data protocol, in 2001 ontwikkeld in Japan, In Icon porto's toegepast

DPMR Digital Private Mobile Radio / BW 6,25 kHz
Technisch Gebruikt FDMA . data 4800 bps / 4FSK modulatie / Trunked Radio standaard ontwikkeld door ETSI / MultiPSK kan niet decoderen

CW BW 1 Hz /  3 kHz - 250 GHz
Morse zien Soms werkt het nog beter om gewoon in SDR# snelheid iets hoger te zetten en dan te zien wat de morse is.
CWget Met CWget kun je visueel maken wat je ziet, is makkelijker / Toon is standaard 1000 Hz / SDRPlay op CW en CWPK zetten
OOK OOK = Simple On-Off Keying modulation

FSK-CW FSK-CW = 2 draaggolven met identieke CW alleen gespiegeld dus als bovenste 1 is, dan in onderste draaggolf 0
NDB (LUCHTVAART) Non-Directional Beacon: Navigatiestations of radiobakens voor luchtvaart tussen 190 KHz en 535 kHz (officieel tot 1750 kHz). Morse ID in 2 of 3 letters. 

NDB bij vliegvelden: Een locator is een NDB die dienst doet als navigatiehulpmiddel voor het aanvliegen van een landingsbaan. Een locator staat 
(vrijwel) altijd recht voor een landingsbaan opgesteld, op een afstand van maximaal 10 NM van het begin van de baan. Een locator heeft een 
tweeletterige identificatie die in morsecode wordt uitgezonden. De reikwijdte van het signaal is zo'n 15 NM (27 KM).

TFS (UTILITY) Time & Frequency Stations: Zend een puls per seconde. Pulsen zijn 100 ms (binaire 0) of 200 ms (binaire 1). Begin van puls is begin van een seconde. 
Aan eind van minuut ontbreekt 1 puls om begin van gegevenspakket aan te geven. Zo wordt iedere minuut in dit datapakket de tijd, dag, datum en 
aanwezigheid van zomertijd uitgezonden.
In MultiPSK modes IEC 870-5 LF gebruiken om tijdzenders (DCF39/DCF49) te decoderen

APRS+PACKET Automatic Packet Reporting System / NFM /  BW 10 kHz / 144.39 - 145.57 MHz
Werking Voor locatierapport en weerstations / 12000 bit/s / AX25 protocol
MultiPSK Decoderen met Amateur > PACKET + APRS (je kan kaart openen waarop positie wordt getoond)
Packet Klinkt als ouderwets inbellen over internetlijn / wordt op 27MC ook nog steeds gebruikt

RTTY (F1B) Ook Baudot of ITA2 genoemd / CW / BW 85 / 170 - 450 - 850 Hz / 147.2 kHz - 28.15 MHz



Werking Radioteletype of telex via radio. Soort knorrend geluid. Heeft twee draaggolven. Er worden digitale codes van 5bits uitgezonden bv 00011 = A.

Afstemmen Mode: Frequency-shift keying (FSK) / In MultiPSK afstemmen op bovenste draaggolf / wel juiste modes instellen in programma

MultiPSK 1) De shift (afstand tussen draaggolven is redelijk eenvoudig te bepalen) / Center zit vaak op 1000 Hz (om juiste frequentie te bepalen)
2) Daarna de verschillende baud uitproberen
3) In CW en stem af op hoogste draaggolf en zet MultiPSK op reverse (soms ook werkt normal). 8.439 Mhz PBB is goede controle want deze zenden een 
continutoon uit en dat is de af te stemmen draaggolf in MultiPSK

MMTTY Xyscope cirkels moeten haaks op elkaar staan, stel shift goed in. Zet in View de FFT op 500k om goed in te kunnen stellen. Met profiles zijn 
voorinstellingen te laten of alles op default te zetten.

Sorcerer FSK > ITA FSK, handmatig juiste shift en speed instellen. niet op invert zetten als via CW wordt ontvangen
PSK31 PSK31 is er voor in de plek gekomen / ontvanger in CW MultiPSK op Reverse zetten

SSTV BW 2500 Hz / 3 MHz - 300 MHz
MMSSTV Altijd instellen onder Option > Setup MMSSTV(O) > TX > Encode FSKID

Onder dit menu is ook onder Misc de soundcard input en output in te stellen en zet Systeem font op Verdana Size -1

HELLSCHREIBER OOK FELD HELL OF HELL GENOEMD / USB / BW 300-800 Hz / 3 - 30 MHz
Werking Verzenden teksten als zw/wit pixels, snel krakend geluid met korte pauzes (2x per seconde)

Aktiviteiten op: 3,580 / 7,037 / 10,137 / 14,063 / 21,063 / 28,120 (klinkt als morse)

Oud systeem Als in 1920 ontwikkeld / wordt beeld overgezet dus geen karakter (teleprinter systeem) / 
Feld Hell In MultiPSK op Feld Hell (normale instelling) of Feld Hell 80
PSK HELL Is een variant van Hellschreiber met de PSK techniek



DOMINOEX

Werking Wisseling van tonen continu na elkaar, meerdere draaggolven, snelheden 4 / 5 / 8 / 11 /16 / 22 baud, in MultiPSK selecteer DominoEX en juiste 
datasnelheid (te zien aan breedte shift), experiment mode voor amateurradio/HAM.

THOR Lijkt erg op DominoEC FEC

THORB

Klinkt Als een zwevend krekelgeluid

MSK8 / MSK16

MSK8 werking Wisseling van tonen continu na elkaar, start met lange laagste toon, 8 draaggolven/tonen, in MultiPSK selecteer MFSK8, Amateur Radio Mode
MSK16 werking Wisseling van tonen continu na elkaar, start met lange laagste toon, 16 draaggolven/tonen, in MultiPSK selecteer MFSK16, Amateur Radio Mode

BPSK31 PSK31 in BPSK mode (31/63/125)
Werking Binair Fasemodulatie: fase wisselt tussen -180 en +180 met gelijke frequentie en amplitude.
Klinkt als Continu toon met snelle kleine toonvariaties, klinkt als alarm met los draadje, een draaggolf, bandbreedte 31,1Hz/31 baud, serieel, in MultiPSK op 

BPSK31 zetten.

QPSK31 PSK31 in QPSK mode (31/63/125)
Werking Als BPSK alleen worden meerdere frequentie binnen zelfde bandbreedte gebruikt.
Klinkt als Continu toon met snel tikkend/krakend geluid, een draaggolf, bandbreedte 31,1Hz/31 baud, serieel, in MultiPSK op QPSK31 zetten.

PSK63F

Werking Blokken met verschillende tonen continu achter elkaar maar wel variaties in blokken, twee draaggolven,  62,5 baud, serieel, Amateur Radio Mode, in 
MultiPSK op PSK63F zetten.

Klinkt als Klinkt als inbelmodem

PSK220F

Werking Continu tonen rond een draaggolf (1000Hz), serieel, Amateur Radio Mode, 220,5 Baud FEC systeem, met MultiPSK te ontvangen
Klinkt als Klinkt als bezetsignaal van Openbaar Vervoer of inbelmodem.

MT63



Werking  63 tonen parallel, amateur radio mode, met MultiPSK te ontvangen (aktiviteiten op 3,590 / 7,038 / 10,135 / 14,347 / 21,130 / 28,130 - decoder IZ8BLY 
MT Terminal)

Klinkt als Knorrend continu geluid.

OLIVIA USB / BW 500 -2000 Hz / 3 - 30 MHz
Standaarden Standaard is 4/125, 8/250, 15/500, 32/1000 en 64/2000 (daarbij staat de 4, 8 enz voor aantal tonen en 125, 500 voor bandbreedte in Hz
Klinkt als Amateurmodes / worden karakters overgestuurd / Continu geluid met verschillende tonen / Start en eindigt met enkele tonen

Wisseling van tonen continu na elkaar, klinkt als onderwatergeluiden
MultiPSK Amateur Radio Mode, in MultiPSK selecteer OLIVIA en aantal tonen en bandbreedte (standaard 32T-1000Hz). Instellingen zijn ook geldig voor Contestia 

en RTTYM.
Contestia Variant van Olivia, minder gevoelig als Olivia en daardoor vaak als chat gebruikt.
RTTYM Is geen RTTY maar gebasseerd op Olivia / Je moet submode (125, 250 enz) en bandbreedte (4, 8, 16 enz) instellen via knop in MultiPSK

FT4 / FT8 / FT2 Coderen met WSJT-X / USB / 3kHz breed
Frequenties Bestaat uit heel veel frequenties waarop data wordt verzonden, deze info is te zien in het programma
FT8 Zenden in 15s
FT4 Zenden in 7,5s / HF-banden en 6 meter / 3,5 dB minder gevoelig en gebruikt 1,6 keer meer bandbreedte (ongeveer 2x QSO snelheid)
FT2 Zenden in 3,8s
Opbouw bericht 1) Twee roepnamen (of CQ, QRZ of DE en een roepnaam) gevolgd door rasterlocator van verzendende station

2) Een signaalrapport
3) R plus een signaalrapport
4) Definitieve bevestiging RRR of 73 als afsluiting (soms wordt ook RR73 gebruikt - dit mag)

MSK144 Deze werkt realtime dus berichten komen direct al tijdens uitzending in beeld

DIGITALE MODES - OVERIGE

STANAG ALS SORCERER OF MULTIPSK GAAT DECODEREN DAN HEB JE EXACTE FREQUENTIE / BW 2,75 kHz / 1,89 - 22,7 MHz / USB
STANAG4285 Door NATO ontwikkeld om snel data te verzenden, 1200/2400/3600 bps / BW 2,75 kHz

Herkenbaar aan brede stroom aan data en rattel zwevend geluid / is short (meer last van fading) of long (minder last van fading) of none
Bijna alijd gecodeerd, met Sorcerer kan Stanag4285 gecodeerd worden

STANAG5030 CW frequentie, midden is 1000 Hz
Klingenfuss Signaal is USB, in Klingenfuss staan CW frequenties dus aanduiding in boeken is dan afwijkend (echte frequentie altijd 1,8 kHz lager)

Tussendoor worden ook soms testberichten en ID's uitgezonden



Sorcerer Zet op 600 LONG en 5N1 Framing, als codering start zie je in bovenste balk o.a. State DCD, correction en ook frequentie error staan. uit (meestal 
gecodeerd)
Lees Bitstream - ITA2 / Center frequentie is altijd 1800 Hz
ZET CENTER FREQ OP 1800 HZ / ALS SORCERER DAN GAAT DECODEREN DAN HEB JE EXACTE FREQUENTIE (SDR OP USB)

MultiPSK Zet op Professional > 4285 (gaat alleen decoderen als je exact op juiste frequentie staat / goede controlemiddel om freq af te lezen)
MIL-STD-188-110A Klinkt als STANAG, MultiPSK kan deze modes ook zenden (Pro > 110A)
STANAG4481 Er is de FSK en PSK modes, FSK kinkt als RTTY

DGPS Differential global positioning system / BW 9 kHz / 25 - 932 MHz / USB
Werking Bij DGPS stuurt een zender continu een correctiesignaal naar een GPS-ontvanger. Deze ontvanger combineert het correctiesignaal en het GPS-signaal 

en bepaalt zo heel precies de exacte locatie. 
De zender die het correctiesignaal uitzendt, kan vast opgesteld staan, maar het kan ook mobiel. Ook kan het correctiesignaal via bestaande netwerken 
zoals GSM verzonden worden.

HF Gebruikt om de positienauwkeurigheid van gps te verbeteren (tot 2 meter kan gehaald worden)
100 of 200 baud / Beste ontvanger op breed bereik USB zetten dan is MultiPSK gevoeligste en kun je er meerdere monitoren

UHF Rond 440 MHz worden ook DGPS signalen uitgezonden, dit kunnen vaste of mobiele opstelplaatsen zijn. Het zijn vergunningsvrije frequenties. Er zijn 
ook vergunde frequenties voor beter beschermd signaal.

ASCII / EFR Ook ITA5 of IRA genoemd / BW 300 Hz / 3 - 450 MHz

Amateurs radio telegrafie, / Klinkt als snelle continu morse, 2 draaggolven
EFR Teleswitch Gebruikt ASCII variant IEC 870-5 / energy management systeem via langegolf / BW 1000 Hz

Decoderen door niet op draaggolf maar op datasignaal af te stemmen /  MultiPSK Pro > ASCII IEC 870-5 + Decoding aan / USB bovenste draaggolf / 
reception normal

DRM Digital Radio Mondiale (DRM) / BW 10 kHz
Werking Digitaal commerciele broadvast mode om FM kwaliteit audio via KG te verspreiden. Bandbreedte meestal 10 kHz maar soms wordt ook bandbreedtes 

tussen de 4,5 kHz en 20 kHz toegepast.
Dream Gratis portable applicatie om DRM te decoderen (audio decoderen nog niet gelukt) / Audio input moet lopen via Virtual Audio Cable / Bij System 

Evaluation zet MLC op 4 en Bandpass Filter AAN / In SDRPlay mode op digitaal, zorg dat hele bandbreedte gekozen is en audio op maximaal. In Dream 
is dan in ieder geval te zien welk programma wordt uitgezonden incl. aanvullende informatie.

Dream AAC decoderen https://www.rarewares.org/aac-decoders.php / faad2_drm.dll moet in zelfde map staan als dream.exe (herken codec wel, geen audio)
SDR# In SDRsharp kun je DRM gecoderen door op USB te zetten met bandbreedte van 10 kHz / VAC Output moet op 2 ch 16 bit 48000 Hz (DVD Quality ) 

staan.



GSM Global System for Mobile communications / BW 9 kHz / 25 - 932 MHz
Werking De wereldstandaard voor mobiel telefoonverkeer waaarin technieken en protocollen zijn vastgelegd / werkt met een rasterpatroon (zendcel) 

waarbij verbinding wordt gemaakt met de steunzender die dichtbij staat of sterktste is.
Benamingen 2G = GSM / 3G = UMTS / 4G = LTE / 5G = NR

POCSAG BW 9 kHz / 25 - 932 MHz 
 Heeft drie snelheden: 512, 1200 en 2400 bps / Personen zoek systemen werken ook met Pocsag (456.45 MHz)

MPT1327 BW 10 / 12,5 / 20 of 25 kHz
Werking In 1988 ontwikkeld analoog trunking netwerk o.a. gebruikt in Europa, UK, Zuid-Afrika, Australie en Nieuw Zeeland. Het controlekanaal regelt op welke 

kanalen het analoge verkeer plaatsvind met een snelheid van 1200 bps. De analoge spraakkanalen zijn eenvoudig af te luisteren.
Klinkt als De vroegere kanalen die politie en brandweer rond de 86 MHz gebruikten.

MOBITEX BW 12,5
Netwerk Wereldwijd zijn er zo'n 30 netwerken die gebruik maken van Mobitex, een van oorsprong Zweedse standaard. In Nederland biedt RAM Mobile Data 

zakelijke datacommunicatie aan met een Mobitex-netwerk. Klanten van RAM Mobile Data zijn bijvoorbeeld hulpverleningsinstanties, openbaar 
vervoer, taxibedrijven, transportfirma's en de Wegenwacht.

Werking Mobitex is een pakketgeschakeld datacommunicatienetwerk. Het maakt gebruik van GMSK-modulatie met een datasnelheid van 8000 bit/s. Door het 
gebruik van deze spectrumefficiënte modulatiemethode is de bandbreedte zo'n 12.5 kHz. De basisstations van RAM Mobile Data zenden op 
frequenties tussen 424 en 425 MHz. De mobiele terminals zenden 10 MHz lager. De gedecodeerde berichten bevatten ruwe 8-bits data. De meeste 
berichten zien er uit als een willekeurige brij van tekens. De data is niet persé versleuteld, maar wordt wel efficient verzonden: klanten betalen per 
byte. De gebruikersapplicatie beslist wat de betekenis is van de data. Dit kan voor iedere klant anders zijn; Mobitex geeft de berichten transparant 
door.

PDW Groot voordeel van PDW is dat van het station in de bovenbalk direct de NetwerkID en BaseID wordt getoond. Vink ook Verbose (control messages) en 
Base Info aan om alle data van station incl. frequentiestatus e.d. te kunnen ontvangen. Hierin staat veel informatie over onderliggende kanalen.

CIS 36-50 / CIS 50-50 / T-600 BW 300 Hz - 550 Hz
 FSK modem gebruikt door Russische Marine, vaak wordt 200 of 250 Hz gebruikt en 50 Baud
CIS 36-50 Ook bekend als BEE-36 en T-600, bitrate 36, 50, 75, 100 en 150 Bd en shift kan 85, 125, 250 en 500 Hz zijn.

RFID / NFC BW 14 kHz / 13.56 MHz
 NFC werkt met RFID / chip in NFC apparaat communiceert met anders NFC apparaat zoals betaalsysteem of smartphone / bw 14 kHz / ook in tags 

gebruikt

RS41 / M19 BW 4,8 kHz  (RS41 - SG)  -  10 kHz (RS92-SGP) - 200 kHz (RS92-KL)



Decoderen met RS41 Tracker Decoderen met RS41 Tracker / werkt via audiouitgang SDR software (SDR++ en SDR# werken, SDRuno deed niets

Decoderen met MultiPSK Decoderen met MultiPSK alleen de informatie is wat beperkt, geen Sonde ID en dergelijke / kan wel meerdere signalen gelijkertijd coderen en 
gekoppeld worden aan kaarten zoals DXAtlas en GoogleMaps

Online volgen https://sondehub.org/ / je kan statische data opvragen door op Plots te klikken en daar je terugzien hoe vaak de data doorgestuurd is / Volg de baan 
van de sonde om startpunt te zien sonde is opgelaten, daar kun je ook launch schema bekijken en prognose welke baan sondes vaak vlogen.

Soorten weerballonnen Leverancier is Vaisala met diverse soorten weerbalonnen / ballon stijgt tot 10-30 km hoogte om data te meten / beste tijd om te luisteren is 14-15 in 
de zomer en 13-14 uur in de winter, dan zitten de ballonnen op grote hoogte / signalen kunnen tot 600 km ver weg komen

M10 Meteomodem M10, coderen met MultiPSK

Software amateurballonnen Decoderen met Horus-GUI telemetry decoder software / audio via VAC / Via SDR++ dan iMet-4 type kiezen

amateurballon online volgen https://amateur.sondehub.org/

KANAALINDELING WIFI 2,4 GHZ

MILITAIRY UHF SATELLITE COMMUNICATION / 240 - 270 MHz

https://amateur.sondehub.org/
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CONDITIES

Goede condities op de VHF en UHF band. Dit werd veroorzaakt door tropo, een propagatie die verschijnt veelal in hogedrukgebieden, doordat er een 
koude luchtlaag zich onder een warme luchtlaag bevindt. 
Dit kan bijvoorbeeld ook het geval zijn bij mist. Signalen boven de 100 MHz komen hierdoor over de horizon en worden pas omgebogen bij het 
bereiken van de warme luchtlaag. 
Tijdens tropo openingen kunnen afstanden van honderden kilometers overbrugd worden.



Naast tropo is er ook nog Sporadic-E, maar dit is een seizoensgebonden propagatie die veelal van mei tot september duurt en ervoor zorgt dat er (pan) 
Europese verbindingen op de 6-meter (en 4-meter) band gemaakt kunnen worden. 
Het loont de moeite om ’s avonds, ’s nachts en/of ’s ochtends eens een slinger aan de set te geven om te kijken of er DX-activiteit is op de 2-meter 
band. Zelf CQ geven op 145.500 Mhz, 
de aanroep frequentie van de 2-meter band, kan soms ook leuke verbindingen tot gevolg hebben.

Area Vliegverkeer






